ANNEX 1 User’s Guide for Computer-Aided Planning

1.

INTRODUCTION

The PW4SP Data Management User’s Guide explains the procedure of encoding data and

generaling tables and figures for the PW4SP. The Guide consists of the following sections:

« Section 2:

« Section 3;

v Section 4:
«  Section 5

« Section 6

Section 7:
« Section 8:

+ Section 9

hardware and software required to successfully run the PW4SP Data
Management

the concept of the microcomputer architecture and an overview of hardware
configurations

fundamentals to operate the systems with internal architecture

basic concept of software operation

~ a complete list of data files and worksheets in the PWA4SP Data Management

System
data linkages
the procedure of updating the PW4SP

standard report format

SYSTEM REQUIREMENTS

The following are the basic requirements to successfully run the PWA4SP data management.

Hardware

Computer
RAM

Hard Disk
Floppy Drive:

Monitor

Printer
Mouse

Miscellaneous:

Software
80486 CPU at 66 MHz Operating System DOS Ver 6.22
8 MB (minimum) Windows Environment : MS-Window Ver 3.11
200 MB (minimum} Spreadsheet . MS-Excel Ver 5.0
3.5 inch High Density Word Proceésing . MS-Word Ver 6.0
5.25 inch High Density | | |
VGA Monitor
80 column

(can handle A4 size papef).
Any brand which supported -
by MS-Windows '
500 watts Automatic Voltage

Regulator and Surgé Protector



3. MICROCOMPUTER SYSTEM

All computers, whether large or small, basically operate on the same fundamental principles,
The hardware and software of a mainframe computer and a microcomputer have the same

components and fulfill the basic functions necessary to any computer system.

The computer is seen as a powerful toal that can enable us to expand the horizons of our
knowledge. It allows processing of large volume of data or complex pattern of information
that would otherwise be difficult to organize and understand. Moreover, it allows for an

easiiy manipulation of data.

There are two major components of a microcomputer: the hardware and the software. These

two components complement each other in order to fulfill their basic function.

A mucrocomputer hardware is made up of several components based on the functions they

perform in the system and how they interact with the other compdanents.

The principal elements of a computer system are:

~« Central Processing Unit (CPU)
¢ Main Memory (RAM) _ _

-« Secondary Storage Devices (disk, drives, magnetic tapes, etc.)
¢+ Input/Output Devices (terminals, printers, etc.)

The CPU does'the actual computing. It is capable .of simple arithmetic and logicai
operations, such as addition and data comparisdﬁ. that are executed at exéeedingly high
speed. The power of a computer directly stems from thé_ speed and accuracy with which the
-CPU can carry out computations and move infdrm_atioﬁ around. ’fhe main memory of the
co:mputef is usually refetred to as Random Access Meinory or RAM. This part of the
* computer contains the programs and information that are currently being pron_:essed by the
CPU. Secondary storage devices, such as magnetic _disk,'is capable of holding large amount
of data. Programs and data are normally stored on these seco'ﬁdary devices and could be
_ tetrieved when needed. They are then loaded into the RAM and execuﬁed. “The results of the
-processing can thcﬁ be written into the secondury storage device or sent to an output device
such as the monitor or.pr'i.nte.r.- Pt:'ri'phcml 'dc\.riccs or InpuUOutpm (I/O} devices allow the
user to- put data .i_nt_o & computer or receive output from a computer, A terminal is a
péripheral__;hat contains_both a keyboard for input and a ‘monitor for output. Other

peripherals include printers and plotters,



The diagram below presents the basic hardware component of a microcomputer system.

Central Processing Unit

(CPU)
I/O Terminal _ Secondary Storage
A
_ Random Access Memory

Keyboard ' ~ (RAM)
> Hard Disk

Monitor  {g—
Q_’. Floppy Drive

Printer | g ' '

Floppy Drive is the most common type secondary storage used in pefsdhal computer today.
It acts as an external drive from which the users insert the ﬂéppy disk to store and retrieve
information. The floppy disk comes in three sizes: 3.5 inches, 5.25 inches and 8 inches. It is
characterized by thin circular plastic sheets coated w-ith iran oxide so_tﬁat magﬁelic patterns
reco-rdcd on it can be retained. The surface is similar to a rﬁagnetic _tape used to record
" music. The disk is contained in a squém cardboard envelope in which it spins. The 3.5
| inches diskette is contaihed in a hard plastic case with a metal shutter that protects the
ma«netic. media. A floppy disk can store from 80 kilobytes to 1.44 megabytes of data.
Floppy disk system is slower and has less storage capacny than hard disk system, but its

lower cost makes it a popular choice for personal computer.

Hard disk is made of _magnctic meta_l, and can aithcr be removable or non-removable, The
most common type of hard disk found .in personal _computér today.'is non-temovable, This
disk typically holds from 10 megabytes to 1 -3 gigabytes of information. Each 'megabyte is
equwalent to | 048 576 characters of information, or rouchly 1,800 smwle—spaced typcwntten

pages; hence, this is a very efﬁcmnt way to store farge volume of information.

Keyboard is an external device that acts as a primary interfac'e'between the humah Opt:rator
and the computer. The keyboard has 3 basic components: the typewntcr keyboard which is
composed of alphabet characters; the calculator pad which is composed of numeric

characters; and the function keys which serve as special macro key for various softwares.

2.36

Sen,
Far s

s

)

A



Monitor is the screen or video display peripheral and serves as the main outpui deviee on a
personal computer. It is used to display text and graphics information and is available in
variety of sizes and ty.pes_. Monitors can be divided into two broad groups; those designed to
display text .infm*mation; and those designed to display graphics information, such as charts or
picture. Within the grdphics group, there are color or monochrome (single colof) displays. A
high quality graphic color monitor is capable of showing high resolution pattern and is

recommended for application in MS-Window, Excel or AutoCAD.

Printer is another common peripheral found in personal computer system. The 2 common
type of printers are dot matrix and laser printer. The dot matrix printer produces iis image by
printing a group of dots that forms the image of a character or symbol. Several methods are
used to create” the péttcm of dots. The most common are impact, thermal and ink-jet
téchndlogies. Tﬁe laser _printcr prbduées its image by means of electrophotograph similar to

the prihciple of photocopy machine.

OPERATING SYSTEM

An operating system is a set of control program that manages the computer’s resources and
create a well-defined software environment for computer applications. Computer hardware

by itself can perform little useful work. A COmputer requires a software to. be able to

* communicate and do useful work, The first layer of software in a computer system is the

. operating system. This is what starts, or boots up; the machine helps in pulling itself up by its

own bootstraps arid establishes a predetermined set of conditions so that applications can be
run. When the computer is turned-on or the reset button is pressed, the control is pass to a set

of control programs found in the ROM, a firmware store in computer chips. These programs

~ perform several tasks: (1) to check if hardwares are functioning correctly; (2) to load a set of

control programs from the disk to the memory; and (3) to pass control to a routine which will
accept the user input. At this point, the operating system is loaded and the user can execute

an application program such as MS-Windows, MS-Word, or Excel.

An operating system by itself has two levels of functionality. The first level is seen by the
user running the applications and utilizing systems commands and utilities. At this level,
eaéﬁ operétiﬁ.g'.systém has its own set bf cofﬁfﬁan_d used fo accomplish frequently performed
tasks such as copyin_g files, renamin:g'ﬁles,. and formattiﬁ_g disks. Normally, frequently-used
functions are in’clhded in the Operéfirfg s'yétem as systei'n boﬁlmands. T he second is at the
programming Jevel, All ()pé,rating systems contain a set of pre-packaged routine, which

performs the “prirﬁitive” functions necessary in almost all applications. Such functions, like
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5.1.

sending a character to the screen, reading and writing information from a disk file, and
accepting input from the keyboard are common to nearly all programs. This level of

functionality gives the programmer a set of standardlzed routines to perform this task.

Operating systems, such as DOS or UNIX contain many uscful utilitics and provide a rich set

of function, which simplify the programmer's job writing apphCﬂth[‘l and controllmcr the

hardwares.

SOFTWARE

The operating system alone renders the computer nearly useless, uniess the user is capable of

directly communicating to the hardware. In order to use the computer system, a software. is
needed. Various softwares are available for dxfferent purposes ‘such as MS. Word for word

processing, Excel for spreadsheet and Foxpro for programming. -

MS-WINDOWS

MS-Windows is a popular software that dupl'icates the function performed by DOS at the

_ system level. Most of the commands.are represented by descriptive figures called icons.
Navigating around the windows is through a pointing device called mouse,  To execute a

. command, the user only need to bring the mouse pointer to the desired command described

by the icon and press the right button. The execution starts without tf'ping .an'y single
character in the keyboard, unlike the DOS convention that needs typing a series of characters
comprising the filename. In windows, the computer screen is referred to as the desktop.
When working, the application and documents mast be in the windows. The windows on the
desktop must also be arran_ged, If an application is left for a while, the windows are shrunk to
an application icon, and stil}, the application keeps running: on the background.  When an
application is shrunk the wmdows place their application icon at the bottom edge of the

desktop until it is again restored to window size.

With wmdows several powerful dppllCJllon\ can be run slmultdneously For example,

swnchmc from a word processing appllco.uon to i spreadsheet and then to database

application with a few simple moves while qummo one application and restarting another

can easily be donc

3
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Two Kinds of Windows

Application windows contain running applications. The name of the applicaiion, the
associated document, and the application's menu bar appear at the top of the- application

window. Application windows can be positioned anywhere within the desktop borders.

Document windows appear only with application that can open two or more docurments at one
tirne taside the same workspace. For example, with Windows File Manager, one can open a
‘numnber of directories at the same time. Each directory appears in a separate document

window {called a directory window) in the File Manager workspace,

Parts of a Windows

Each application and some documents the user choose to work on, open as separate windows.

Every window has some common elements, however, nat all windows use all the items.

The elements as iflustrated below are the toals for working with the window and the

-application or document within the window.

nsertign p_ain! Window titla

Control-manu box

Minferiza butten
Maximiza button

S5 w5

; £dit Sesrch  Help Menu bar
Ay
it +
| u
T _ = Window border
—— Vertical
scroll bar

: 12
hel T N N )
\- Windox corner _ \- Mouse pointer \- Horizantal scroll bar

The Control-menu bax located in the upper-left comer of the window is the most useful
“menu when the use of u Keyboard is preferred. The Controf-menu commuands can resize,

move, maximize, minimize and close windows. and switch to Task List



The title bar shows the name of the application or document. If more than one window is

open, the title bar of the active window has a different color or intensity compared to the

other title bars.

The window title, depending on the type of window it appears, can be the name of an

application and the name of the document, or a placeholder. In such case, “untitled” -

normally appears,

The menu bar hsts the dvmlable menus. Most appllcatlons have a File menu, an Edit menu,

and a Heip menu as well as other menus unique to the apphcatmn

The Scroll bar can move the parts of the document into view when the entire document will
not fit in the window. With the bar, unscen portion of thc hsts and other information that is

too long to fit in the allotted space can also be viewed,

The Maximize and Minimize buttons enlarge the active application window to fill the entire

desktop or shrink the window to an icon. Document windows enlarge just to fill the

application workspace and not the entire desktop. After enlarging the window, the Maximize

button changes to a Restore button. Restore button can be used to return the window to iis

previous size,

The Window border is the outside edge of a window. " It can lengthen or shorten each side of

the border.
The Window corner can be used to shorten or lengthen two sides of a border at the same time.

The Workspace is where most of the work with an application are done. For example, the
content of the documents appears in the workspace when starting a wordprocessor. Hence,

an application can aflow the opening of more than one document window within this

workspace.

The selection cursor shows where the user is in an individual document. It rnarks the place

in the text or graphics where the user bevins' typing or drawing. - The arrow-shape mouse
pointer appears if you have a mouse mstallcd It is used to indicate items the user wants to

select with mouse.
Stacting Windows

At the DOS prompt, type win and press ENTER,
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When starting windows, the Program Manager window is automatically opened with the

Main Group window opening inside it and other window groups represented as group icons

located at the lower edge of the Program Manager window as show in the illustration in

balow, -

Fle Managa [TU00TRTY Post Marager Cirnboad H$005

Wiedowe PIF Editar AeziMe
Fatug

M FTE 112
428 42% 4%t
Gamer

Accertonizs |

Quitting Windaws

Mouse . 1. Quit any application that are currently running.
© 2. Click Program Manager's File menu to open it.

. Click Exit Windows.

The Exit Windows confirmation dialog box appears.
. Click OK to exit windows,

LT

B

Keyboard I. Quit any application that are currently running.
Press ALT-F to open Program Manager’s File Menu.

. Press X (the underlined letter in Exit).
Or use arrow key 10 move the highlight w Evit Window
and the press ENTER.

. The Exit Windows confirmation dialog box appsars.

. Press ENTER 1o choose OK and exit windows,

(3]

o)

Starting Window Applicstion
To make starting application easy, Window offers three methods;

Choosc & pmumm m:m from a group wmdow in Procmm Munager.

Chooac d program file from the approprmtc: chr::ctory wmdow in File Muanuger,

Chooxe the Run command from the Fila ntenu in Proomm M.umucl or File Mdna"c.r



- Starting Applications from Program Manager

&

As long as an application belongs to a group, the easiest way to start is to choose from the
group window. If a document is included with the application, it will be loaded into the

application workspace.

Mouse L. Open the Program Manager window. if not already open,
and open the group window that contain the application
you want {o start.

2, Double-click the icon for the application.

Keyhoard 1. Open the Program Manager window, if not already open,
' and open the group window that comam the application
you warit to start.
2. Use the arrow keys to move the hlghl:ght to the icon for
application.
3. Choose Open from the File menu and press ENTER.

Starting Applications from File Manager

You start an application from File Manager by opening the prooram file from a dlrectory

window. You can execute an apphcatlon procrram file hawncr LCOM, EXE PIE, or BAT
filename extension. If the apphcat:on can run in a window environment, the window will

appear in front of any File Manager windows that are open.

Mouse I. Start File Manager and open the directory wundow
: that contain the program file.
. Double-click the filename.

R

Keyboard 1. Start File Manager and open thc d1rectory wmdow
that contain the program file.
. Use the arrow keys to move the highlight to the icon for
application. o

. Choose Open from the File menu and press ENTER..

2

[P

Starting Applications with the Run Command

The Run command is a handy way to start applications that you want to run only occasionally
or have not vet ddded to a group. You can open 2 document ut the same time you start the -
application. Unless the program file i$ in your current path you need 0 know the exact g

directory location and name of the prograi file before you can start the apphcataon.

l. Choose Run from the File menu in Program Manager or File Manager.
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The Run dialog box appears.
2, Type the pathname and the exact filename of the program file, including
) the extension if there is one.
= 3. If you want the application to shrink to an icon as soon as it starts, make
sure the Run Minimized check box contain an X.
4. Choose OK or press ENTER,

52. MS-EXCEL

Excel is a spreadsheet type of software package that operates under the MS-WINDOWS
operating systerﬁ. The primary document in Excel is called a workbook. The workbook is
similar ta a ledger that stores inforrnation and each warkbook is made up of sheets. The
sheet is virtually divided inta column and row; the column run horizontally and denoted by an
alphabet starting with A ‘and the row run vertically and denoted by number starting from 1.
The intersection of column and row is called cell, The cell is the basic companent of
worksheet that accept different data typeé. The mast common data types are character,

number, date, Iogica_l' value and formula.
Standard Toolbar
The standard toolbar that normally appears at the top of screen helps select aptions. Such

options can open workbook, print and save waorksheet, and ask for help. The following is a

list of the individual icons and their respective functions.

Excel’s Sfcndurd Toolbar

Button Naome ‘Function’
0 New Workboak Creates a new workbock
Open Opens a document
. Save Saves the actve workbaok
&
Print Prinw the active workbook
@; Print Preview Shows the active dogument in pring preview
made '
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Excel’s Standard Toolbar %ﬁ%

=
Button Nome ~ Function
Ty
721 Speller Checks the spelling of the document
2
batedd Cut Cuts the selection to the Clipboard
B o o
- Copy Copies the selection o the Clipboard
' ’g Paste Places the Clipboard contents at the insertion
< : point :
Format Painter Copies and pasies formuacs for cells and objects
o
B Undo Undoes the last acton or command
‘@‘ Repeat Repeats the last action or command;

this is the same as the redo feature in Waord 8

AutoSum Inserts che SUM Ffunciion and shows'sum range
Funciicn Wizard Searts the Function Wizard

AT L o L

Zy Sort Ascending Sorus selected rovws in ascending ocder

Z: '

AT Sort Descending Sores selected rows in descending order

T

Ll . i - . . e -
ChartWizard Acgtivaces the ChariWizacd

Text Box [nsers text or texe hax

Drawing Turﬁs the dl;n\\'ing tgolbar on or off
100z i‘;] Zoom Cantrol . Sets the view of LH: document
' ‘ Tip \\.'iznrd Tuirns the TipWitard teolbar ::;u or off
X‘? B Help . Displayvs Help




oy

;

Excel’s Formatting Toolbar

Button Naome Function
Arial : II * ] _
— Font Sets the {ont for the sclectan
] 10 I ' Font Size Sets the font size for the
i selecton
: ‘ Bold Boldfaces the setecdon

= s |
7 . - .
e Tralic Iwalicizes the selectian
o .
A T .

EES Underline Underlines the selecdon
== : .
= Align Left Lefe-aligns che selecdon
_— .
[t Cenier Centers the selecdon
e Align Right Right-aligns the selection
'@ Center Across  Centers the selection across
favio] o " Columuns columris
:—gg' " Curreney Changes the selected cells to
e Sgle . default currency soyle

_ -.,'-'/-" g Pergent Changes the selected cells to
piafind Sovle d=fault pereent sole
EEE Comma Changes the selected cells o
i Stvle default comma seyle
::';!_}‘:'0 [ncrease " Adds one decimal place to
308 Decimal the number format
200 Decrease Removes one decimal place
>0 Decimal from the number format
[ 1% Barders Enables you ta sefecta
- border for the selection -
*'(5" iy Color Seis the colar for the
L — selection '

g Font Color

Sets the color for the sefected

fane




Basic Part of Excel Screen

Memil bor
File  E£dit View |nscr Fgrmni Yools Doata ‘_-Mmdnw ucSp : -
Too‘bor;——E (CEREEF ETEEE [~ =] R I@mlﬂﬂmo; _____ E][:| 7}
i EII EJIEIILJEIMXI I H"*I-H“ﬂ
Pl AL BT C B D e ErphRAETe [ G i W] TS
1 {Sales Tnln1:: Far Eext Divisign
7 J-Figures iy milllans]} ; 5.0
iy . 1992 1393 se0
_'-_i_.!_lpln . §$£4.3 529 - el
B YT S T i =121 il
6 |Ching [£E:] [ 520 = 1553 :
N : : s1.n
-4 . SEE— _
'1_0'_ - - — Japan Kores China
112 |
3
14
“Workboak ——— 15
G | -
H]-q]}lu,]\ ausu;,{ F- a1l ) FasEaat 2
Reéaly Rt k| G o | S | A v s | ettt | [ e T INUNL o [ -mr”
MS-Excel Basic Qperation Tabs Warkshee!

Following the description of the basic operatian, the mouse is used as 2 pointing device
instead of a keyboard. The wdrd click means the user must press the left button of the
mouse; double click means (wo successive clicks; and enter means the user r'nust. press the
Enter key in the keyboard.  Basic operation dealt only ta the routine necessary to update the

PW4SP darta base.

Creating a New Worksheet

When you enter Excel, it opens up to a new workbook, by default it contain 16 worksheets.
You can use any of the worksheets, Even if there is an open workbook, you can siill open
another by moving the mouse pointer in the New icon (upper left of the screen below the

menu bar). Click on it

Saving the Warkbook

. Move mouse pointer to File menuand click on it to bring the File mcnu_op_tion.

. From the option availuble, Select Save.

. If the document your siving is new. The Save As dmlou box Jppear ‘[n the File Name
box type the name of the workbook.

'.a-‘ I3 —

Enter Data in a Celi

1. First select the cefl by moving the mouse pointer and clicking the
right button, This routine place the insertion point in the active cell,
which is highlighted on-screen with border around it
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2. You can start entering the data from your keyboard or numeric keypad.
3. To confirm the input, you can press ENTER or move the mouse pointer
to the Forrnula bar and ¢lick the Check icon.

Editing Cell Contents

1. Double-click the cell containing the data you want to edit.
To edit in the formula bar, click in the formula bar. In case the formula
bar is not displayed, choose Formula Bar from the View menu tocated
at the top row of screen,

2. Edit the cell contents. :

3. To confirm the modification made in the cell, click the Check icon in the
formula bar or press ENTER. To cancel edits, click the X icon in the
formula bar or press ESC.

Clearing Cells

I. Select a cell or range of cells that you want to clear.

2, From the Edit menu, choose Clear, and from the option available,
you the choose All, Contents, Formats, or Notes,
Shortcut: Press DEL.

To.clear cells by dragging

t. Select a cell or range of celis that you want to clear.
2. Move the mouse pointer in the fill handle (fower right corner),

g drag the fill handle toward the area of cell or range, then the se]ected
area will become gray.
3. Release the mouse button.

Co'pyin g Cells

1. Select the cells containing the data you want to copy.
2. From the Edit menu, choose Copy.

3. Select the upper-left cell of the paste area.
Beware that any values or formula in the paste areq will be replaced.

Undo Command

i. To undo your last command, click the Undo button.
From the Edit menu, choose Undo,

Creating Border around Cell

. Choose the Cell menu from Format menu,
2. Choose the side you want put the border and Lhcn choose type of border. -
3. Click OK button.

~ Deleting Rows and Columns

. Select the row or column .
To deleté more than one row or column extend the belecllon to include
all the rows or colurmns you want to delete.
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2. From {he Edit menu, choase delete (Entire rows or column) »aa’%.
3. Click OK button @

Inserting Rows and Columns

I. Select the row or columnn
To insert more than one row or column. extend the selection to include
the number of rows or colurnins you want to insest.

2. From the Edit menu, choose Insert {Entire rows or column)

3. Click OXK button.

Selecting a Sheét ar Sheets
To select a single sheet, click the sheet tab.
To select two or more sheets
1. Click the sheet taE for the first sh:;_et you want to seléct.

2. If the sheets you want to select are adjacent, hold down the SHIFT key
and click the tab for the last sheet.

If the sheets you want to select are non- adjacent hold down the CTRL key
and click the other sheet tabs.

Ungroup Selected Sheets

1. Move the mouse pointer to the sheet tab. Click the left button 6f the mouse.
2. While the mouse pointer still on the sheet tab, click the noht button .md
choose the Ungroup Sheets.

Inserting Worksheet

1. Select a sheet or sheets in the workbook,
2. From the Insert menu, choose Worksheet..

The new sheet or sheets will be inserted to the left of the 5heet tab you select.
Shorteut: SHIFT+F1 1

Deleting Worksheet

1. Select a sheet or sheets in the 'work'bbok

2. Move the mouse pointer to the sheet tab, and click the right button,
3. Choose Delete, and click the OK button.

| Moving Worksheet Within the Workbook

l. Select the sheet or sheets you want to move. .
2. Drag the selected sheet tab along the row of tabs, -
A black triangle indicates the place where the 5hecl\ will be- mscrted. Q
All selected sheets will be inserted. '

3. Release the mouse bution.



Alternate Method

1. Select the sheet or sheets you want to move.
2. From the Edit menu, choose Move or Copy Sheet.

3. In the Before Sheet box, select where you want sheets to be inserted.
4, Click the OK button.

Moving Sheets to Other Workbook

1. Open the workbooks you want to move sheets ro and from.
2. Select the sheet or sheets you want to move.

3. From the Edit menu, choose Move or Copy Sheet,

4. In the To Book box, select the destination workbook.,

5.1In the Before Sheet box, select where you want the sheet or sheets inserted.
6. Click OK button.

: Altemative Method

. Open the workbooks you want to moeve sheets ro and frorm,
2. From Window menu, choose Arrange and choose horizontal.

In the desktop, two workbooks will apen in screen split the workarea horizontally.
. Select the sheet or sheets you want to move,
4. Hold-down the CTRL key and the right button of the mouse.

A paper icon and black triangle indicate that you made the move routine active.

5. Drag the mouse pointer to the other workbook and select where you want

- the sheet or sheets inserted.
6. Release the mouse button.

—

W

Copying sheets within a werkbook

L. Select the sheet or sheets you want to copy.

2. Hold down the CTRL key and mouse left button, and then drag the selected
sheet tab along the row of tabs. A black triangle indicates the place where
the copied sheet will be inserted.

3. Release the mouse button and then the key.

Alterative Method

1. Select the sheet or sheets you want to copy.

2. From the edit menu, choose Move or Copy Sheet,

3 In the Before Sheet box, select where you want the copied sheet inserted.
4. Select the Create A Copy check box.

5. Click the OK button

_ Cdpying sheets to other workbook .

1. Opeii the workbook you want to copy to and from.
© 2, Select the sheet or sheets you want to copy.
3. From the Edit ménu, choose Move Or Copy Sheet.
?g o 4. [n'the To Book box, seléct the destination workbook.
- ' 5. In the Before Sheet box, select where you want the copied shest inserted.
6. Select the Create A Copy check box. '
7. Choose the OK Button.
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5.3.

Printing your Work

1. From File menu, choose Page Setup to display the Page Setup dialog box.
2. On Page Setup dialog box, their are four option available

Page rab controls page orientation, scaling, page size, prmt quality, and
starting page number for the selected shect.

Margin 1ab controls page margins and the header and footer margins, and
center the sheet on the page vertically, horizontally or both.

Header/Footer rab controls page the headers and footers for the selected sheet.
headers and footers are descriptive text that print at the top and bottom of
every page in your sheet. You can add, delete, edit, format, and position
headers and footers, and view them as they will print.

Sheet tab specifies which areas of the sheet you want o print, and controls
the print titles, page order, and draft quality. Also controls whether
gridlines, cell notes, and row and column heading print. The Sheet tab is

_ displayed if the active sheet is a warksheet or macro sheet.
‘3. On the Print What, their are three option available. _

Selection option prints only the selected cells in the selected sheets,

Nonadjacent selections are printed on separate pages. Selecting this
. overrides any print areas you have defined for the selected sheets using
Print Area opticn on the Sheet tab of the Page Setup dialog box.

Selected Sheets option prints the area of each of the currently selected sheets,
with each print area starting on a different page. If no print area is defined
on a separate sheet, the entire sheet'is printed,

Entire Workbook option prints the entite print aréa of all sheets in the active

- workbook. If a sheet does not have a print area, that entire sheet is printed.
4. On the Copies box, specifies the number of copies to print.
5. On the Page Range, their are two option available.
All option print all the pages in the selected sheets.
Page(s) option print the range of pages specified in the From and To boxes.
- Page numbers you selected in the From and To boxes affect which cells
-will be printed, not the numbering of the pagesupon which they are
printed. To change the numbering of printed pages, specify a number in
the First Page Number box of the Page tab in the Page Setup dialog box.
6. The user have option to see the appearance of the print by chckmcr the
Print Preview button.
7. Printer Setup option give the user an optlon to select among the available
printer drivers,
8. Click the OK button to proceed prmunﬂ

MS-WORD

MS-Word is word processing type of software. This is analogous of converting your
computer into typewriter muchine.-You have page in which ycu type characters, you have a
ruler that show where you are as you type across the’ paue You hive tabs stops ind margin

settings. The insettion pomt moving across the page even acts like the prmt head moving

across the page.
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MS-Word offer more advance features that you need to create from simple to complex type
of document. When you start Word you will notice almost the identical appearance with that
of MS3-Excel. Most of the command are represented in terms of icon, in the middle of the

workspace were you enter your text and other object included in your documents. -

Starting Word

From the MS-Window environment, you can double-click the MS-Ward icon in the MS-
Office program group. fn some case the MS-Office administrator is automatically loaded at
start-up of Windows environment. The MS-Office administrator menu icons are located in

the upper right side of the screen. You can start MS-Waord by clicking the icon.
Quiting Word

I. Move mouse pointer to File menu and click. File sub-menu will appear,
2. From the File sub-menu, move mouse pointer to Exit option and click,
The MS-Word environment will normally terminate. In some cases, if some actjve

documents has not yet been save. MS-Word give the user's option to save the
documents. ' '

Standard Toolbar

The standard toolbar which normally shown at the tap of screen helps you select the aption,
from this toolbar, Th";' user’s can open new; dacument, open exi_s'tin'g document, print and save
document, and ask help to farther understind some function or proce;dure fo accomplish
desired task, Using the toolbar speed-up the desire task instead of using the menu (located at
the top of the screen). The following shows the list of standard toalbar icons and their
function.

Standaord Toobar [cons

lean Name Descriplion

)

New Creates a new file based an the Normal template

Open Displays the Qpen dirlog box so that you can select an
existing file to open

~ @E W

Save Saves the current document

Print Prings the current document

Print Preview Activates Waird's print previéw [eawires -
E '
el . Spelling Inidates o spelling check




Standard Toobar lcons

lean Nome Description

& Cut Cuts selected material (o the Windows Clipboard
Copy Copies sclecied macerial o the Clipboard
Paste Pastes material from the Clipboard into your docu-

ment

Formart Painter

Copies the formatung of a selection (o Lh: (c\L)ou

. specify.

ElElE

Py ig ] Undo Undoes the commands you select fram the fist

] —

—d presented

"e‘(.;‘ ¥} Redo Redoes the commands you select from the list pre-
L sented

AutoFormat

Formau your document automatically

Insert AutoText

Inserts an AuteText enery

ElElE

Insert Tabi;:

Inserts a mable into your document

Insert Excel

Inserts an Excel worksheet i into.

Worksheet your doecument
Columns Formats your document using columns
Drawing Opens the drawing applicadon and enables you to

draw a picture in vour document

SrSmE

"Liadse
i

Insern, Chart

Inserts a chartinto vour document

¥

Zoom Conerol

Scales )our view of Lhc documcm b) the pcrccnugc
you select

Help

Activates context-sensitive help

MS-Word Basic Operation

Opening and Existing Document

I. Click the Open Folder icon (normaily second from the left) to l:mmT up the open
dialog box. :

2. In the Open Dialog box select the fite you to open from File Name combination

box.

3. Click the OK button.

Changing the Format of the Text

i. Click the arrow bution to the rlnht of lhejnnr box 1o brlnw lh:: h\t of avitiuble Ion[
Scroll through the list box by clicking on the acro!l bar, and select a fong by clicking

2.

LpJ

on it,

Brwm typing. The text will appear in lht: tont you just selected
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Changing the Font Size

L. Click the arrow button to the right of the font size box 1o bring the list of avallablc

size.

2. Scroll through the list box by clicking on the scroll bar, and select a size by clicking

on it.

3. Begin type. The text will appear in the font size you size selected,

Choose a Style

Perform any of the following procedures to change a font style:

Click on the button labeled B to set the bold feature on.

You also can press Ctrl+-B from the keyboard. '

Click on the button labeled I to set the italic feature on,

You also can press Ctrl+I from the keyboard,

Click on the button labeled U to set the underfined feature on.

You also can press Ctrl+U from the keyboard.

Click on the button labeled B and I to set both bold and ilalic features
You also can press Cirl+B followed by Cirl+I from thie keybourd.

Setting Special Effects

You can use a variety of special text effects:

~ Strikethrough

Supetscript
Subscript
Hidden
Small caps
All caps

To set any of these features, use the following procedure:

el B

-4,
3.

Open the Fermat menu and select the Font item.

. If the Fonts tab is not on top, click on it.

In the Effect group box, select the check box that represent the special effect
you want to turn on. o

Click the OK button.

Bewln typ:no Your text appears with the spec:ai cffr:ct you selected.

Setting the Indentation

1.

Open the Format menu and select the Paragraph item.

2. If the Indents and spacing tab-is not on top. click on it.

3.

In the indentation group box, use the Left and Right spin boxes to set the indentation
from the left and right margm'i Click on the arrow buttons until the measurement is

* correct, or select the text in the body by highlighting it with the mouse and then type

exuact measurement you want.

4. To sét first line or hanging indentation, open the Special drop- down fist box by

clicking on its arrow, and select the appropriate item, Use the By spin box to set the
measirement for the first line indentation or the hunging indentation.

3. Click the OK button Your currem paragraph takes on the mdentatien you just set,

' Bach subsequent paragraph you create takes on this pattern, unless you reset the
indentation using the dialog box.

v
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Setting Line Spacing

Open the Format menu and select the Paragraph itemn.

If the Indents and Spacing tab is not on top, click on it.

In the Spacing group box, use the Before and After spin boxes to set the distance in
points from the previous paragraph and from the following paragraph. Click on the
arrow buttons until the measurement is correct, or select the text in the box by
highlighting it with the mouse and then type the exact measurement you want.

- To set line spacing within the paragraph, open the Line Spacing drop-down list box by
clicking on its arrow, and select the appropriate item. Then use the: At spin box to set
the measurement for number of lines or distance between lines, whichever is active.

- Click the OK butign. Your current paragraph takes on the line spacing you just set.

Each subsequent paragraph you create takes on this pattem, unless you reset the line
spacing using the dialog box.

UJK\J:--

S

Ln

Copying and Inserting Text

1. Highlight the text by drag ing the mouse pointer over lhc text to be selected.
2. Move pointer to Copy icon and click on it.

3. Move mouse pointer to the place were you would like the insertion take place.
4. Move mouse pointer to Paste icon and click on it. Allematwely, you can press the right
button of the mouse to bring the menu option., select the pastc by click onit.

Undoing and Redoing

If you dd make a mistake, you can undo it by selecting the Undo option from the E_dit meni,
This procedure undoes the last change you made to the document. Word éfways witl add the
name of the operation you are about to undo as the second word of the Undo menu item. If

you cannot undo anything, this option change to Can’t Undo and is dimmed.
Overstriking Text

Thérc_ are times, however, when you want to type over éxistiﬁg text. To switch to this editing
mode, press the Insert key in the keyboard. When you type, the characters you type replace

any characters to the left of the insertion point. To tum off the overstrike inode, press the

Insert key again.

Deleting Text

Use mouse pointer to highlight the desire text and press the Del key from the keyboard.

Insert File

1. Move mouse pointer in the location were you wou!d hke the mseruon take place.
2. From the Insert menu, select File option.
3.

From the File name comblnauon box, select lhe f'le you would like to insert.
Click the OK button.




Creating the Header or Footer

}. From the View menu, choose Header and Footer. _
2. The Header and Footer toolbar appear, click the switch between Header
and Footer button. The header and footer areas are enclosed by a nonprinting
dashed line.
3. Do one or more of the following;
Text - You can type the text within the dashed line that surround the header
or footer area.
Page Number - Click the icon.
Current Date - Click the icon.
Current Time - Click the icon.
4. To return to the document, choose the Close button on the Header and Footer
toolbar, or double-click the main text area

Previewing the Document

1. From the File menu, choose Print Preview.

While in the print preview mode, you can perform the following optmns

a) You can print the document by click the Print button,

b) You can switch the magnifier on and off by clicking on the magmﬁer button

¢} You can switch to a one page view by clicking the One Page button.

d) You can switch to view multiple pages by clicking an the Multiple
Pages Button and dragging across the grid that appears, releasing the
miouse button when you have the multiple-page view you want to use.

e) You can zoom in or out on your document by adjusting the zoom
percentage in the Zoom Control drop-down list box.

f) You can switch the view of the ruler on and off by clicking on the
View Ruler button. '

2) You can squeeze a small amount of text on the final page mto the
the outer pages by clicking on the Shrink to Fit button,

h) You can expand the preview screen to show only the page, the
toolbar, and the status bar clicking on the Full Screen button.

1) You can exit the preview mode by clicking on the Close button.

Printing your Document

1. From the File menu, choose Print option.
A Print dialog box appear. :
2. In the Print Whar drop-down list box. This opticn enabl'es yau to print the
document or several iterns ancillary to the document, such as Summary Info,
* Annotation; Style, Autotext Entries, and Kéy Assignments.
3. Use the Copies box to enter the number of copies to print.
4, Use the Page Range option to determine how much of the document to print.
~ You can print All the document, the Current Page, ar selected Puges.
5. Check the Collate Copies check box to finish the first set of copy before
~ printing the second copy.
6. When all it set comrectly, close all the dialog boxes you have open,
and click QK button, the printing process begin.



6.1.

PW4SP DATA FILES

" Data files are collection of information revelant to the preparation of PW4SP, Data files are

logically group into three major areas of information. The first group of information are the
base data that are composed of information derived from survey, ocular inspection, and

existing information from the provincial and national agencies. The second group of

information are the key parameter data that are composed of information derived from

applicable policies, assumption, water test result, and current cost of commodity. The third
group of information are the présentatib’n of data which derived from the previously
mentioned groups of information’s, this data are proce§sed and then logically arranged to
show provincial profile, existing fac1ht|es and service coverage, past financial performance

future reqmrement of the relevant sector, cost estimates for future sector development, and

financial arrangement.

Base Information

1. Socio-economic Data (socio.x1s)

a) Administrative Compos:tlon { (M) Administrative Composmon)

b) Past Population ( (M) Past Population Page | to 2)

¢) Projected Population { (M) Projected Popuidn_on)

d) Household { (M) Household)

e) Services ( (M) Services)

f) Occupation ( (M) Occupation)

g} Family Income, Education and Literacy ( (M) Fam:!y Income and Education)

t

. Land Use Data (landuse.x!s)

ay Existing Land Use ({M) Existing Land Use)
b) Future Land Use ((M) Future Land Use)

3. Health Data (health xls)

a) Morbidity, Mortallty and Infant Mortahty ((M) Morbtdity and Mortallty)
b) Facility and Practitioner (M) FacilityPractitioner)

4, Water Resource Data {h ores. xls)

a) General Information ( (M) General Inform.mon)
b) Water Source Information { (M) Source Informat_lon) :

5. Water Supply Systems Data (h2osupp.xls)
a) Levet III Systems ( (S) Level Il P1-2 ., P2-2)
b) Level Il Systems ( (S) Level IL P1-4 .. P4-4)
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6.2,

6.3.

6. Environmental Sanitation Data (sanit.xls)

a} Household Toilets ( (M) Household Tailets)

b) School and Public Toilets ( (M) Sch. and Pub. Tailets)
c) Drainage Facility ( (M) Drainage Facility)

d) Solid Waste Collection and Disposal { (M) Solid Waste)

7. Invesiment Data {invest.xls)

a} Previous Annual Investment { {P) Fin. Past Ann, Invest)
b) Planned Annual Investment { {P) Fin. Future Ann. Invest.)

Key Parameter

1. Key Parameters (kcypar xls)

a) Key Parameter (Key Parameter)
b) Level I - Safe and Unsafe (Level I Safe and Unsafe)
¢) Well Source Compaosition {Well Source Composition)
d) Unit Cost (Unit Cost)
e) Scoring Factor (Scoring Factor)

_ ) Annual Investment (Annual Investment)

Data Presentation

1. Provincial Profile (chap-?.x.ls)

a) Outline of City and Municipalities (MTable 3.1.1)
b) Current Land Use (MTable 3.2.1)
¢) Drainage Areas and Flow Rates of Major Rivers (MTable 3.2.2)
d) Distribution of Households by Income Class (MFiwure 33D
¢) Population Distribution by Occupation {Figure 3.3.2)
f} Population Distribution by Highest Attainment of Education (Mqure 333
g) Provincial Qutline on Public Setvices (MTable 3.3. 1)
h) Public Facilities and Services by Municipality (MTable 3.3.2)
i) Previous Population Development of the Province (MFigure 3.4.1)
j) Previous Population Development by Municipality (MTable 3.4.1)
k) Present Population Distribution (MFigure 3.4.2)
) Outline of Urban and Rural Areas in the Province (MTabIe 3.4 2)
m) Household Numbers and Household Sizes {MTable 3.4.3)
n).Number and Rates of Ten Leading Causes of Marbidity,
Mortahty and Infant Mortality (MTable 3.5.1)
o) Reported Cases and Deaths of Notifiable Water Related Diseases (MT.lb!L 337
p) Municipal Solid stte Collection and DIprhdl dnd
Service Coverage in 1994 (MTable 3.6.1) '
q) Number and Ratio of Population to Health Facilities
and/or Medical Practitioners (STable 3.5.1)
1) Types of Drainage Facilities (STable 3.6.1)
s) DENR Water Quality Criterie/Water Usage and C'lamfu..mon
for Fresh Water (STible 3.6.2)

2. E.tistfng Facilities 'and S'e}-i.rfce Coverage (chap_.-4.x[s)

a) Information on Existing Level III Sy;;jte’rns.(M'l_'_‘ﬁbl'c 4.1.2)
b) Information on Water District (MTuble 4.1.3)
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c) Information on Existing Level I Systems (MTable 4.1.4)
d) Information on Existing Level [ Facilities (MTable 4.1.5)
e) Water Supply Service Coverage by Municipality in 1994 (MTable 4.1.7)
[} Water Supply Service Coverage by Municipatity (MFigure 4.1.1)
g) Sanitation Facilities and Service of Househald Toilets, Urban and
Rural, 1994 (MTable 4.2.1)
h) Provincial Service Coverage of Household Toilet Facilities, 1994 (MFigure 4.2.1)
i) School Toilet Facilities and Service Coverage in 1994 (MTable 4.2.2)
j) Public Toilet Facilities and Service Coverage in 1994 (MTable 4.2.3)
k} Details on Existing Level III Systems (STable 4.1.1 Sheet 1 t0 4)
1) Details on Existing Level I System (STable 4.1.2 Sheet 1 to 6)
m) Number of Level I Facilities by Safe and Unsafe Classification (STable 4.1:4)
n) Estimation of Unserved Population by Municipality (STable 4.1.5)
0) Estimation of Population Covered by Safe and Unsafe Source
by Municipality (STable 4.1.6 Sheet 1 10 2)
p) Sanitation Facilities and Service Coverage of Household Toilets
by Type, by Municipality, Urban and Rural, 1994 (STabte 4.2.1)

3) Past Financial Performance in Water Supply and Sanitation (chap-6.xls)

a) Previous Sector Investment to the Province by Concerned Agency (MTable 6.2.1)
b) Past Intemnal Allotment to the Province from Central Government (MTab!e 6 2.2)
¢) Affordability in Water and Sanitation Services (MTable 6.4.1)
d) Financial Indicators of Water Districts (MTable 6.5.1)
e) Loan Status of Water Districts (MTable 6.5.2)
f) Past Intenal Revenue Allotment o Mumc:palmes from

Central Govemmem(STable 6.2.1) '

4) Water Source Deve!opmenr (chap 7.x1s)

a) Emsnna Groundwater Sources i in the Province (MTable 7 i: l)

b) Work Flow of Groundwater Ava:labllny Map (SFigure 7.3.1)

¢) Existing Spring Sources by Municipality (STable 7.4.1)

d) River Information and Related Data (STable 7.5.1)

e) Water Quality Analysm Results {STable 7.5.2)

f) Existing Well Sources (STable 7.6. 1) : _
g) Standard Spemfu.auon of Wells by Mumc:pdlity (STab[e 756. 7)

5) Future Requirement in Water Supp[y and Sanir’aiibn Environment (chap-8.xls)

1} Provincial Sector Targets (MTable 8.2 I) _ . .
2) Base Year Service Coverage of Water Supply (MTdble 8.2 )
3) Base Year Service Coverage of Household ‘Toilets (MTab!e 8.2 1)
4) Base Year Service Coverage of Public School Toilets and '

Public Toilets (MTable 8.2.4)
5) Base Year Service Coveraﬂe of Mumczpai Solid Wa‘:te Syslem in I994 (MTable 8.2.5)
6) Future Population by Urban and Rural Arez by Municipality (MTable 8.3.1)
7) Projected Public School Enrollment and Number of Publlc Utility

by Municipality (MTable 8.3.2)
8) Population to be Served by Target Year (Water Supply) (MTable 8.5. i)
9) Additional Number of Households to be Served. by Target Year

(Household Toilets) (MTabie 8. 52)
10) Additional Number of Public School Student to be Served by .

Target Year (School Toilets) (MTable 8.5.3)
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11) Additional Number of Public Utilities with Sanitary Toilets
by Target Year (MTable 8.5.4)
%’% 12) Popuiation to be Served by Urban Sewerage in Phase I (MTable 8.5.5)
: 13) Additional Nuraber of Urban Households to be Served by
Municipal Solid Waste Systemn in Phase [ (MTable 8.5.6)
14) Water Supply Facilities Required by Target Year (MTabie 8.6.1)
15} Sanitation Facilities Required by Targel Year {MTable §.6. 2)
16) Number of Garbage Collection Trucks Required in Phase ¥ {MTable 8.6. H
[7) Estimation of Base Year Service Coverage of Water Supply (STable 8.2 Ay
18) Population Coverage in Phase I Provided by Served Population
in the Base Year (STable 8.2.2)
19) Number of Households Served by Sanitary Toilets in the
Base Year (1994)(STable 8.2.3) :
20) Number of Public School Student Served by School Toilets in the
Base Year (STable 8.2.4)
21) Number of Public Utilities with Sanitary Tonlets in the
Base Year (1994) (STable 8.2.5)
22) Households Coverage in Phase I Provided by Existing Facilities in the
Base Year (Household Toilets) (STable 8.2, 6) -
23) Public School and Public Caverage in Phase I Provided by
Existing Facilities in the Base Year (STable 8.2.7)
24) Préjected Number of Households by Urban and Rural Areaa by
Municipality by Target Year (STable 8.3.5)
25) Projected School Enrollment by Municipality by Target Year (STable 8.3, &)
26) Projected Number of Public Utilities by Municipality by Tatrget Year (STable 8.3.7)
27) Population to be Served by Level Il System in ‘Phase I (STable 8.5.1)
28) Population to be Served in Phase I (Water Supply) (STable 8.5.2)
@ '29) Population to be Served in Phase IT (Water Supply) (STable 8.5.3)
30) Additional Nurnber of Houseliolds to be Served in
Phase I (Household Toilets) (STable 8.5 4)
31) Additiopal Number of Households to be Served in
~ Phase II (Household Toilets) (STable 8.5.5) _
- 32) Additional Number of Public School Stidents to be Served in
Phase [ and II (School Toilets) (STable 8.5.6)
33) Additional-Number of Public Utilities with Samtary Toilets in
Phase [ and II (§Table 8.5.7) '
- 34) Urban Water Supply Facilities Required by Turget Year (STable 8.6.1)
35) Plan for Expansion of Existing Level IIl Systern (STable 8.6.2)
36) Rural Water Supply Facilities Required by Target Year (STable 8.6.3)
37) Urban Household Toilets Required by Target Year (STable 8.6.4)
38) Rural Household Toilet Required by Target Yeur (STable 8.6.5)
39) Public Schooi Toilets Required by Target Year (STable 8.6.6)
40) Public Toilets Required by Target Year (STable 8.6.7)

6) Cost Estimates for Future Secror"Develoﬁmerir (chap-10.x1s)

* a) Unit Cost of Facilities by Type and Service Level (MTable 10.2.1)
b) Construction Cost of Required Facilities by Municipality (MTable 10.3.1)
" ¢) Recurrent Cost (ViT..lb[e 10.4.1) :
~d) Unit Cost of Level I (Deep Well - 40 meter Depth) (STabh: 0.2.1
&) Unit Cost of Level [ (Deep Well - 80 meter Depth (STabie 10.2.2)
"-B) Unit Cost of Leve! [ (Deep Well - 120 meter Depth) (STable 10.2.3)
g) Unit Cost of Level [ (Deep Well Rehabilitation) (STable 10.2.4)
h) Unit Cost of Level [ (Shallow Well - |8 meter Depth) (STabie 10.2.5)
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1) Unit Cost of Level II (600 Service Population) (STable 10.2.6)
J) Unit Cost of Level I (5,000 Service Population) (STable 10.2.7)
k) Unit Cost of Level IIT (10,000 Service Population) (STable 10.2.8)
1) Unit Cost of Level TIT (15,000 Service Population) (STable 10.2.9)
m) Unit Cost of Flush Water Sealed with Septic Tank Toilet (5Table 10.2.10)
n) Unit Cost of Pour Flush with Double Pit Latrine (STable 10.2.11)
o} Unit Cast of Ventilated Improved Pit Latrine ($Table 10..2.12)
p) Unit Cast of School Toilet {STable 10.2.13)
q) Unit Cost of Public Toifet (STable 10.2.14)
1) Construction Cost of Water Supply Facilities Required for

Phase I (2000) (STable 10.3.1)

s) Construction Cost of Water Supply Facilities Required for -

Phase I (2010) (STable 10.3.2) '

t) Cost of Sanitation Facilities Required for Phase I (2000) (STabEe 10. 3 3)
u) Cost of Sanitation Facilities Requlred for Phase II (2010) (STable 10.3 4)

1) Financial Arrangements (chap-11.xls)

a) Projected Internal Revenue Allotment for Medium-Term
Sector Development (MTable 11.2.1)
b) Projected Allotment of IRA to the Relevant Sector by
Component, 1996-2000 (MTable 112.2) '
c) Financing Requirements by Sector Componcnt for the Province (MTable 11.3.1)
d) Additional Fund Requirement for Medium-Term Plan (MTable 1£.3.2)
e) Internal Revenue Allotment for Water Supply and Sanitation Sector -
by Mummpahty (Medium-Term Developmernit 1996- ”000) (MTable 11.3.3)
f) Relationship between Funding Levels and Percent of Coverage :
for Water Supply Sector (MFigure 11.4.1)
g) Relationship between Funding Levels and Percent of Coveraoe -
for Sanitation Sector (MFigure 11.4.2):
h) Municipal Investment Need Ranking for Urban Water Supplv (MTubIe 11.4.1)
i) Distribution of Provinciil IRA to Municipality for
Urban Water Supply (MTable 11.4.2) '
J) Municipal Investment Need Ranking (MTable | | 4 £
k} Percentages for Annual Investment (STable 11.3.1).

1) Comprehcnswe Investment Need Ranking of the Municipalities (STab[e 11.4.1)

DATA FILES LINKAGES

Llnkuves are logical connection between records in the data files, Throuch linkages, once the
user’s updates the source data, all data in the streums of linkages are dynamlcally updnted
Linkages are the convenient tools of updating’ rclau:d data; these also ahleld the user's from

the complexﬂy of formula manipulation. With the and of the dala hnkagea thc user's can

concentrate more in validating the source data. . ‘ . g

The following table lists the logical conneétions for each workshset,
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8.1.

UPDATING PW4SP DATA BASE

The following procedures are guide in updating the base data of the PW4SP data
rmanagement system. The word column and row in this procedure mean the intemal column

and row notation in the worksheet environment,

Updating Socio-economic Data Base

1. Click the File menu, select Open.
Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the socio.x!s filename.
3 | To update the Administrative Composition Data,
click the tab of (M) Area and Population sheet.

« NEDA geopgraphic code: move mouse pointer to column A. Starting at the row
below the column’ description, select the data you would like to update and type the
" new value.

. Muﬁici_pa! Name: move mouse pointer to column B. S{é.rting at the row below the
column descripticn, in reference to column A (NEDA geographic code) select the
data you would like to update and type the new value.

» * City: move mouse pointer to column C. Starting at the row below the column

description, in reference to column B (name of municipality) select the data you |

would like to update and type the new value.

»  Municipal: move mouse pointer to column D. Starting at the row below the column
description, in reference to column B (name of mun:c:pallty) select the data you
“would like to update and type the new value, :

+  Class: move mouse pomtcr to column E. Stamno at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

» Urban Barangay: move mouse pointer to column J Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value,

* Rural Barangay: move mouse pointer to column K. Starting at the row below the
column description, in reference to colurmnn B (name of mumcupallty) select the data
you would fike to update and type the new value,

3.2 To update the Past Poimlatidn Data,
click the tab of (M) Past Population Page I sheet.

» 1903. move mouse pointer to column D: Starting at the row ‘below the column
description, in reference to. column B {name of municipality) select the duta you
would like to update and type the new value. :

« 1918: move mouse pointer to column E. Starting at the row below the column

description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.
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1939 move mouse pointer to column F. Starting at the row below the colurmn
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value,

1948 move mouse pointer to column G. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you

- would like to update and type the new value.

1960. move mouse pointer to column H. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
would like to update and type the new value.

1970: move mouse pointer to column I. Starting at the row below the column

description, in reference to column B (name of municipality) select the data you
would like to update and type the new value,

~ 1975: move mouse pointer (¢ colamn J. Staing at the row below the column

description, in reference to columnn B (name of municipality) select the dara you

would like to update and typc the new value.

click the tab of (M) Past Population Page 2 sheet.

Urban Population (1980): move inouse pointer te column D. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

~ Rural Population (I1980): move mouse pointer to columm E. Starting at the row

below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

‘Urban Population (1990): move mouse pointer to column G. Siarting at the row

below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

. Rural Population (71990): move mouse pointer to column H. Starting at the row

below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

Urban Population (1994): move mouse pointer to column J. Staning at the row
below the column description, in reference to.column B (name of municipality) select
the data you would like to update and type the new value.

Rural Population (1994); mdve moﬁse pointer to column L Starting at the row below
the’ column desunpt:on in reference 10 column B {name of munlupahty) select the
data you would like to upda:e and type the new value.

3.3 To_ updatc the Pop_ul_ation Projeciion Data,
- click the tab of (M) Project Papulation sheet:

Urban. Population (2000): moye mouse pointer lo. column [ Stasting at the row
below the column description, in reference to ¢olumn B (nume of municipality) select.

thr: data ycu would like to update and type the new value.,

Rural Populat:an (2000) move mouse pointer to colump K, Starting at the row
below the columin description, in reference to column B (name of municipality) select

the data you would like 10 update and type the new value.



»  Urban Population (2010); move mouse pointer to column S. Starting at the row
below the column description, in reference to column B (name of mumc;pality) select
the data you would hke to update and type the new value.

+  Rural Population (2010). move mouse pointer to column U, Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value,

3.4 To update the Household Data,
click the tab of (M) Household sheet.

+ Urban Household (1980) mOVe mouse pointer to column D. Starting at the row
below the column description, in reference to column B (name of municipality) seleet
the data you would like to update and type the new value.

e Rural Household (1980): move mouse pdinter to column E. -Staning at the tow
below the column description, in'reférence to column B (name of municipality) select
the data you would like to update and type the new value.

»  Urban Household (1990): move mouse pointer to coiumn G. Starting at the row
below the column description, in ‘reference to column B (name of municipality) select
 the data you would like to update and type the new value.

s  Rural Household (1990): 'mc_jve mouse pointer to column 'H. Starting at the row
below the column description, in reference to column B (name of municipality) select
_ the data you would like to update and type the new value,

» Urban Household (1994): move mousé pointer to column J. "Staning at the row
_below the column.description, in reference to column B (name of mumcxpahty) select
the data you would like to update and type the new value

» Rural Household (1994); move tHouse: pointer to column K. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value,

- 3.57To update the Services Data,
click the tab of (M) Services sheet.

¢ Number of Public 'Elemenrary School: move mouse pointer 0 column F, Starting at
the row below the column description, in reference to column B (name of
municipality) select the data you wauld hkc to updatc and type the new value.

s«  Number of Private Elementary School move mouse pointer to column G. Starting
at the row below the column description, in reference to _cqlumn B (name of
municipality) select the data you would like to update and type the new value.

«  Number of Public High School: move mouse pointer to column . Stanihg at the row
below the column description, in reference to columin B (name of municipality) select
the data you wou!d like'to update and type the new value. '

» Number of Private High School: move mouse pomter to coiumn 1. St.mmrr at the
row below. the column description, in reference to column B (name of mummpahty)
. select the data you would like to update and:type the new value. '

»  Number of Colleges: move mouse pointer to column L. Starting at the row below the g
column description, in reference to column B (name of municipality) select the dam
you would like to update and type the new value.
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*  Number of Hospitals: move mouse pointer to column M. Starting at the row below
the column description, in reference to colurmm B (name of municipality) select the
data you would like to update and type the new value,

¢ Number of Markels: move mouse pointer to column N. Starting at the row below

the column description, in reference to column B (name of municipality) select the
data you would like (o update and type the new value.

*  Number of Banks: move mouse pointer to colurnn . Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

3.6 To update the Qccupation Data,
click the tab of (M)} Occupation sheet.

» Number of Professional,Technical and Related Warkers: move mause pointer to
column D. Starting at the row below the column description, in reference to column

B (name of mumctpahty) select the data you would like to update and type the new
value.

-

. Number of Administrative, Fxecutive and Managerial: move mouse pointer to
column E. Starting at the row below the column description, in reférence to column B

{name of mumcxp&hty) select the data you would like to update and type the new
value, :

*  Number of Sales Workers: move mouse pointer to column F. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

Number of Service Workers: move mouse pointer to column G. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

«  Number of Agricultural, Animal Husbandry & Forestry Workers, Fisherman and
Hunetrs, move mouse pointer to column H. Starting at the row below the column
description, in reference to column B (name of municipality) select the data you
“would like to update and type the new value.

Number of Praduction & Related Workers, Transpeortation Equipment Operators
and Laborers: move mouse pointer to-column I. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

Number of Occupation Not Adequately Defined or Reported: move mouse pointer
to colurnn J, Starting at the row below the column description, in reference to column

B (name of municipality) select the data you wauld like to updutc and type the new
value.

3.7 To update the Family Incomé, Education and Literacy Data,
click the tab of (M) F am:’ly Income and Education sheet,

. ‘Number of Family Receiving Under P 13,999: mave mouse pointer to column D.
. Starting at the row below the column description, in reference to coluron B (name of
municipality) bClﬁC[ the data you would like to update and type the new value.

e Number of Family Receiving Between R 15,000 to P 29,999: move mouse pointer
to column E. Starting at the row below the column description, in reference to
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column B (name of mumcnpahty) select the data you would like to update and type
the new value.

Number of Family Recciving Between £ 30,000 to £ 39,999 move mouse pointer
to column F. Starting at the row below the column description, in reference to
column B (name of rmunicipality) select the data you would like to update and type
the new value.

Number of Family I’ecewm; Between P-40,000 to £ 5%,999. move mouse pointer
to column (. Starting at the row below the column description, in reference to

column B (name of municipality) seiect the data you would like to update and type
the new value. '

Number of Family Receiving over £ 60,000: move mouse pointer to column H.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.,

Number of Pop_ulai‘ion that Finish Pre-School: move mouse pointer to column 1.

Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value,

Number of Population that Finish Elementary School. move mouse pointer to
column J. Starting at the row below the column description, in reference to column B

(name of municipality) select the data you would like to update and type the new
value.

Number of Population that'Finish High School: move mouse 'p_ointer to column K.
Starting at the row below the colurmn descriptian, in reference to column B (name of
municipality) select the data you' would like to update and type the new value.

Number of Population that Finish College and Post Graduate, tove mouse pointer
to column L. Starting at the row below the column description, in reference to
column B (name of mumcxpahty) select the data you would like to update and type

'the new value

Number of Literate Population: move mouse pointer to ¢olumn M. Starting at the
row below the column description, in reference to column B (name of municipality)
select the data you would like to update and type the new value, .

Number of illiterate Population: move mouse pointer to column N. Starting at the
row below the column description, in reference to column B (name of municipality)
sefect the data you would like'1o update and type the new value.

Updating Land Use Daia Base

I. Click the File menmu, select Open.
Short-cut: Click the Gpen button.
2. From the Open Dialog Box. Select the landuse.xls ﬁlcnamc
3.1 To update the Existing Land Use Data,
click the tab of (M) Existing Land Use sheet.

Forest Land Area: move mouse pomter to columit C. Starting at the row below the
column déscription, in reference to column B {namé of municipality) select the data
you would-like 1o update and type the new value. -
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¢ Grass Land Area: move mouse poinler to column 1, Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value,

i,

«  Built-up Land Area: move mouse pointer to column E. Starting at he row below the

¢olumn description, in reference to column B (name of municipality) select the data
you wonld like to update and type the new value.

*  Agricultural Land Arca: move mouse pointer to column F. Starting at the row below
the column description, in reference to column B (name of municipality) select the
data you would like to update and type the new value.

*  Mangrove, F:shponds In- land Area: move mouse pointer to co!umn G. Starting at
the row below the column description, in reference to column B (name of
municipality) select the data you would like 1o update and type the new value.

¢ Open Land Area: move mouse pointer to column H. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

3.2 To update the Future Land Use Data,
_click the tab of (M) Future Land Use sheet.

* Forest Land Area: move mouse pointer to column C. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update .md type the new value.

« Grass Land Area: move mouse pointer to column D. Startmg at the row below the
“column description, in reference to column B (mame of municipality) setect the data
-you 'would like to update and type the new value. -

e Built-up Land Area: move mouse pointer to coturnn E. Starting at the row below the
column description, in reference to cofumn B (name of mumupdhw) select the data
you would like to update and type the new value

s Agricultural Lami Area: move mouse pointer to \..oiur'm F. Starting at the row below
the column description, in reference to column B (name of municipality) select the
data you would like to update and type the new value.

. Mangrave,'Fishpdﬁds,' In-land Area: move mouse puinter to column G. Starting at
the tow ‘below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

¢ Open Land Area: move mouse pointer to column H. Starting at the row below the
column description, in reference to column B (name of mumnicipality) seleLt the data
you would like to update and type the new value,

83.  Updating Health Data Base

1. Click the File menu, select Open
Short-cut: Click the Open button,
2. Frorn the Open Dialog Box. Select the health.xls f“ lename.
3.1 To update the Morbldlty, Mortahty and Inl.mt Mortahty Data,
chck the tab of (M) Morbidity and Mortalx:y sheet,
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8.4.

Number af Morbidity Case: move mouse pointer to column E.- Starting at the row
below the column description, in reference to column C {name of diseases) select the
data you would like to update and type the new value.

Number of Mortality Case: move mouse pointer to column F. Starting at the row
below the column description, in reference to column € (name of diseases) select the
data you would like to update and type the new valne.

Number of Infant Martaliry Case: move mouse pointer to column G. Starting at the
row below the column description, in reference to column C (name of diseases)
select the data you would like to update and type the new value. .

3.2 To upidate the Facility énc_l Practitioner [¥ata
click the tab of (M) Facility and Practitioner sheet.

Number of Hospital Facility: move mouse pointer to column D. Starting at the row
below the column description, in reference to column B (name of mummpahty) sélect
the data you would like to update and type the new value.

Number of Rural Health Unit (RHU) move mouse pomter to column E. Starting at
the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Number .of Barangay Health Station (BHS): move mouse pointer to column F.
Starting at the row below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

Number of Practicing Doctors: move mouse pointer to column H. Starting at the
row below the column description, in reference.to column B {name of mumc:pahty)
select the data you would like to update and type the new value.

Number.of Pracficing Nurses. move mouse pointer to column L. Starting at the row
below the column description. in reference to column B {name.of municipality) select
the data you would like to update and type the new value.’

Number of Pmcncrng A’Izdwwes move mouse pointer to column J. Starting at the
row below the column description, in reference to column B (name of municipality)
setect the data you would like to update and type the new value.

Number of Pract:cmg Denhsts move mouse po:nter to column K Starting at the
row below the colurmn description, in reference to column B (name of municipality)
select the data you would like to update and type the new value,

Updating Water Reso.urt:_es Data Base

1. Click the File menu, select Qpen.

Short-cut: Click the Open button.

2. From the Open Dialog Box. Select the h2o-rex. xls filename..
3. To update the General Information Data,

click the tab of (M) General Information sheet.

Number of Shallow (General Information): move mouse pointer to column E/H.
Starting at the row below the columin description, in reference to column C-
(description of information) select the data you would like to update und type the
new value,
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*  Number of Deep Well (General linformation): move mouse pointer to colurnn F/L
Starting at the row below the column description, in reference to column C

(description of information) select the data you would like to update and type the
new value.

«  Number of spring (General Information): move mouse pointer to column G/J.
Starting at the row below the column description, in reference to column C

(description of information) select the data you would like to update and type the
new value.

Note: To add succeeding municipality. Copy (M) General Information sheet and

erase the default data and type the new daia follc;wm0 the aforementtoned
procedures.

Updating Water Supply Data Base

L. Click the Eile menu, select Open.

Short-cut: Click the Open button
2. From the Open Dialog Box. Select the hZosupp.xis filename.
3.1 To update the Level TIT System Daia,

click the tab of (S) Level IIT PI-4 sheet,

* Data: move mouse pointer to column G.Starting at the row below the column

description, in reference to column B (Info Description) select the data you would
like to update and type the new data.

click the tab of (S) Level [II P2-4 sheet.

« Data: move mouse pointer to column G.Starting at the row below the column
description, in reference to column B (Info Descnpnon) select the data you would
like to update and type the new data.

click the tab of (S) Level IIT P3~4 sheet,

- Data: move mouse pointer to column G.Starting at the row below the column
description, in reference to column B (Info Descnpuon) select the data you would
like to update and type the new data.

click the tab of (S) Level I_H P-4 sheet,

«  Data; move mouse pmnter to column G.Starting at the row below the column
description, in reference to column B (Info Description) :elcct the data you would
llke to update and type the new ddtd '

3.2 To update the Level If System Data,
-click the tab of (S) Level Il F1-2 sheet.

« Data: move mouse pointer to column G.Starting at the row below the column
_-description, in reference to column B (Info Description) select the data you would
like to update and type the new duta. :



click the tab of (S) Level [T P2-2 sheel.

Data: move mouse pointer to column G.Starting at the row below the eolumn

description, in reference o column B (Info Descnpnon) select the data you would
like to update and type the new data.

3.3 To update the Level I Facility Data,
click the tab of (F) Level I sheet.

Public Facility:

»

Deep Well: move mouse pointer to columnn E Starting at the row below the colurnn
description, in reference to co]umn B (narme of municipality) select the data you
would like to update and type the new value,

Shallow Well: move mouse pointer to column F. Stamnv at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value.

C‘overed/!mproved Dug Well: move mouse pomter to column G. Starting at the row
below the column description, in reference to column B (name of ‘municipality) select
the data you would like to update and type the new value.

Open Dug Well: move mouse pointer 1o column H. Startinc at the row below the
column description, in refcrence to column B (name of municipality) select the data

you would like t6 update and type the new value.

Developed Spring: move mouse pointer to column L. Starting at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value,

Undeveloped Spring: move mouse pointer to column J. Starting at the row below the
column description, in reference to column B (name of mumcapallty) select the daia

© You would like to update and rvpe the new value

Private F. acility:

Deep Well: move mouse pointer to column L., Startmo at the row below the column
description, in reference to column B (name of mumc:pdhty) select the data you
would like to updatc and type the new valuc

Sha!low Well: move mouse pointer to column M. Stamnv at the row below the
column description, in reference to column B (name of municipality) select the data
you would like to update and type the new value,

Cavered/Improved Dug Well: move mouse pointer to column N. Smmno at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

Opcn Dug Well: move muouse pointer to- coiumn O. Starting- at zhe row bciow thc
column description, in reference to column B (name of municipality) sefect the data
you would like to update and type the new value.
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¢+ Rain Collector: move mouse pointer to column P, Starting at the row below the
column deseription, in reference to column B (name of municipality} select the data
you would like to update and type the new value.

8.6. Updating Environmenta! Sanitation Data base

1. Click the File meny, select Qpen,

Short-cut; Click the Open button.
2. From the Open Dialog Box. Select the sanit.xls filename.
3.1 To update the Bousehold Toifet Data,

click the tab of (M) Household Toilets sheet.

«  Number af. Urban Households Using Water Sealed Flush Toilet: move mouse
pointer to column C. Starting at the row below the column description, in reference

. to column B (name of mumc:pdhty) select the data you would like to update and type
the new value,

.= Number of Rural Households Using Waier Sealed Flush Tailet: move mouse
pointer to column D. Starting at the row below the column description, in reference

to column B (name of municipality) select the data you would like to update and type
the new value,

+  Number of Urban Houselolds Using Water Sealed Pour Flush Toilet: move mouse
pointer to column E. Starting at the row below the column description, in reference to

colurnn B (name of mummpahty) select the data you would like 1o update and type
the new valuc ' .

g - . Number aof Rural Households Using Water Sealed Paur Ftush Toilet: move mouse
' pointer to column F. Starting at the row below the column description, in reference to

“column B {name of mumc:lpahty) seiect the data you would like to update and type
the new value,

*  Number of Urban Households Using VIP Latrine Toilet: maove mouse pointer 10

~ column G. Starting at the row below the column description, in reference to coturnn

B (name of municipality) select the data you would like to update and type the new
value. ' '

«  Number of Rural Households Using VIP Latrine Toilet: move mouse pointer to
column H. Starting at the row below the column description, in reference to column

B (name of municipality) select the data you would like to update and type the new
value,

«  Number of Urban ‘Households Using Um’anu'ary Toilet: move mouse pointer to -
~ column K. Starting at the row below the column description, in reference to column

B (name of mummpahty) select the data you would like to update and type the new
vatue. . .

«  Number of Rural Houscholds Using Unsanitary Toilet; move mouse pointer (o

. column L. Starting at the row below the column description, in reference to column B

~(name of mumcxpat:ty) select the data you would like to update und type the new
value,

. Numbef of Urban Houscholds -Without Toilet: move mouse pointer to column N.
- Starting at the row below: the ¢olumn description; in reference to column B (name of
municipality) select the data you would like to update and type the new value,
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o Number of Rural Households Witlhout Toilet: move mouse pointer to column O.
Starting at the row below the column description, in reference to column B (name of
municipality} select the data you would like to update and type the new value.

it

L
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click the tab of (M) School Toilets sheet.

e Number of Public School: move mouse pointer to column C. Starting at the row
below the column description, in reference to'column B (name of municipality) select
the data you would like to update and type the new value. -

»  Number of Private School: move mouse pointer to column D. Starting at the row
below the column description, in reference to column B (name of municipality) select
the data you would like to update and type the new value.

s« Number of Student in Publm Scheol: move mouse polmcr to co!umn F. Starting at
the row. below the column description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

e Number of Student in Private School: move mousc pointer to column G. Starting at
the row below  the column description, in reference to column B (name of
mumcxpahty) select the data you would like to update and type the new value.

e Number of Sanitary Toilets in Public School: move mouse pointer to column I
Starting at the row below the column description, in reference to column B (name of
“municipality) select the data you would like to update and type the new value.

e  Number of Samtary Toilets in Private School: move mouse pointer to column J.
Starting at the row befow the column description, in reference to column B (name of
muricipality) select the data you would like to update and type the new value.

*  Number of Unsamtary Toileis in Pubhc School; move mouse pointer to cotumn L.
Starting at the row below the column description. in reference to column B'(name of
rnunicipality) select the data you would like to update and type the new value.

«  Number of Unsanitary Toilets in Private Schoal: move mouse ‘pointer to column M.
Starting at the row betow the column descrlptlon in reference to column B (name of
mumcxpaltty) select the data you would like to update and type the new value.

click the tab of (M ) Publ:c Toilets sheet.

¢ Number of Public Markets move mouse pointer to column C. Stamnu at the row
~ below the column description, in reference to column B (name of municipality) select
. the data you would like to update and type the new value.

»  Number of Sanitary Toilets in Public Markets: move mouse poinier to column D.
Starting at the row below the calumn description, in reference to column B (name of
municipality) select the data you would like to update and type the new value.

¢  Number of Unsanitary Toilets in Public Markets: move mouse’ ‘pointer to column E.
-Starting at the row below the column description, in reterence to column B {name of
municipality) select the data you would like to tipdite and type the new value.

s Number of Jeepney/Bus Terminals: move mouse pointer (0. column G. Starting at
the row below the colimn descrlptmn in reférence to column B (name of
municipality) select the data you would like to update and type the new value. : g



Number of Sanitary Teoilets in Jeepney/Bus Terminal, move mouse pointer to
column H. Starting at the row below the column description, in reference to column

B (name of municipality) select the data you would like to update and type the new
value.

Nurmher of Unsanitary Toilets in Jeeprney/Bus Terminal. move mouse pointer 1o

colurnn I. Starting at the row below the colomn description, in reference to column B

(name of municipalily) select the data you would like to update and type the new
value,

Number of Parks/Playground: move mouse pointer to column K. Starting at the row
below the column description. in reference to column B (name of municipality) select
the data you would like to update and type the new- value.

Number of Sanitary Tailet.é in Parks/Playground: move mouse pointer to column L.
Starting at the row below the column description, in reference to column B (name of
municipality} select the data you would like to update and type the new value.

Number of Unsanitary Toilets in Parks/Playground: move mouse pointer to column
M. Starting at the row below the colomn deseription, in reference to column B (name
of municipality) select the data you would like to update and type the new value. .

click the tab of (M)} Dreinage Facility sheet.

Length of Drainage Main: move mouse pointer to column C. Starting at the row
below the column description, in reference o column B {namne of municipality) salect
the data you would like to update and type the new value,

Length of Open Channel (with concrete and mazonry). move mouse pointer to
colurnn D, Starting at the row below the column description, in reference to column
B (name of municipality) select the data you woutd like to update and type the new
value. :

Length of Open Ditches And Unlined Laterals: mavé mouse pointer to column E.
Starting at the row below the column description, in reference to column B {(name of
murnicipality) sclect the data you would like to update and type the new value.

' Length of Remfarced Cancrete Circular Pipes: move mouse polnter to column F.

Starting at the row below the column description, in reference to column B (name of

* municipality) select the data you would like to update and type the riew value.

Length of Street Gutters: move mouse pointer to column G. Starting at the row
below the column description, in reference to column B (name of municipality) sefect

- the data you would like to update and type the new value,

' Length af Ourfaﬂc To szers From Dramage Mains: move mouse pointer to

column H. Starting at the row below the column description, in reference to column

B (name of municipality) select the data you would like to update and type the new
vajue,

click the tab of (M) Solid Waste sheet.

l\umber of Open Dump Trucks move mouse pomter to column C. Starting at the

row below the column description, in reference to column B (name of municipality)
-select the data you would fike to update and type the new value,
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*  Number of Closed Type Trucks: move mouse pointer to column D. Starting at the
row below the column description, in reference to column B (name of municipality)
select the data you would like to update and type the new valuve.

*  Number of Households Served By Open Dump Site: move mouse pointer to colurnn
F. Starting at the row below the column description, in reference 1o column B (name
of municipality) select the data you would like to update and type the new value,

*  Number ofHouséhélds Served By Sanitary Landfill: move mouse pointer to column
G. Starting at the row below the column description, in reference to column B (name
of municipality) select the data you would like to update and type the new value.

*  Number of Househalds Depending on Dumping on Land or Water: move mouse
pointer to column H. Starting at the row below the colurnn description, in reference

to column B (name of mummpality) sclect the data you wouid like to vpdate and type
‘the new value.

e Number of Households Depending on Burying: move mouse pointer to column L
Starting at the row below the column description. in reference to column B (name of
rnummpalltv) select the data you would l:ke to update and type the new value.

*»  Number of Households Depending on Composting: move mouse pointer to column
J. Starting at the row below the column description, in reference to columi B (name
of municipality) select the data you would like to update and type the new value.

Updating Investment Data Base

1. Click the File menu, select Qpen.

Short-cut; Click the Ogen buiton. - :
2. From the Qpen Dialog Box. Select the invest.xls ﬁlename
3.1 To updatg the Past Investment Data,

click the tab of (P} Past Invest sheet.

*  Shallow Well: fnove mouse pdint'er fo column _'C.__S'taning at the row below the
column descyiption, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

* - Deep Well: move mouse pointer to column D: Starting at the row below the column

description, in reference to column A (name of fundmg aﬂcncy) select the data you _

would like to update and type the new value

s . Spring Development move mouse pointer to column E Stzu’un'J at the row below
the column description, in reference to column A {name of funding agency) select thc
data you would Iike to update and type the new value

o Well Rehabilitation: move Tmduse pmme o bolumn F Stamnv al the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

* Rain Collecfor: move mouse pointer to column G. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to Updd[e and type the new value.:

e Level I System: move monse pomter o column, H Starting. at- the row below the
column description, in reference o column A (name of funding agency) select the
data you would like to update and type the new value.
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Level IIT System: move mouse pointer to column 1. Swriing at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

Sewer System: move mouse pointer to column J. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value.

*  Private Latrines: move mouse pointer to column K. Starting at the row below the
column description, in reference to colamn A (name of funding agency) select the
data you would like to update and type the new value.

* School Toilets: move mouse pointer to column L. Starting at the row below the
column description, in reference to column A (aume of funding agency) select the
data you would like to update and type the new value.

*  Public Toilets: move mouse pointer to column M. Starting at the row below the
column description, in reference to column A (name of funding agency) select the
data you would like to update and type the new value,

3.2 To update the Planned Future Investment Data
' chck the tab of (P) Future Inves! sheet,

¢ Project Name: move mouse pointer to column A. Starting at the row below the
column descrlptlon type the project ldennﬁcatlon

+  Type of Pro_;ect move mouse pomter to column B. Starting at the row below the
column description, in reference to column A (name of project) type the new value.

*  Phase of Project: move mouse pointer ta column C. Starting at the row below the
column description, in reference to calumm A {name of project) type the new value.

* Project Location: move mouse pointer to column D, Startimg at the row below the
column description, in reference to column A (mame af project) type the new value,

* Implementing Agency: move mouse pointer to column E. Starting at the row below

. the column description, in reference to column A {name of project) type the new
value.

¢ Start Date of Project: move mouse pointer to column F. Starting at the row below

the column description, in reference to column A (name of project) type the new
value. :

” Cdrﬁpletiah Date of the Praject; move mouse pointer to column. G. Starting at the
row below the column description, in reference to column A (name of project) type
the new value.

* Accomplishmeni Status (%): move mouse pointer to column H. Starting at the row
below the column description, in reference to column A (name of prOject) type the
new value

o Number of Hoﬁsehold'Co'vered by the Project: move mouse pointer to calumn I
Starting at the row below the column description, in reference to column A (name of
project) type the new value.

*  Finance Agency: move mouse pointer to column J. Starting ut the row below the
column description, in reference to column A (name of project) type the new value.




Cost of Level I Facility (Thousand of pesos): move mouse pointer to column K.
Starting at the row below the column description, in reference to column A {name of
project) type the new value,

Cost of Level I System (Th.ousand of pesos): move mouse pointer to column L.
Starting at the row below the column description, in reference to column A (name of
project) type the new value.

Cost of Level {IT System (Tfiousand of pesos): move mouse pointer to column M.
Starting at the row below the column description. in reference to columin A (name of
project) type the new value.

Cost af Sewer System (Thousand of pesas) move mouse pointer to column N.
Starting at the row below the column description. in reference to column A (name of
project) type the new vaiue.

Private Latrine (Thousand of pesos): move mouse pointer to column O. Starting at

the row below the column description, in reference to column A’ (name of project)
type the new value,

Cost School Toilets (Thousand of pesos): move mouse pointer to colﬁmn P. Starting

at the row below the column description; in reference to column A (name of project)
type the new value.

Cost of Public Tau'ets (Thousand of pesos): move mouse pomter to column Q.
Starting at the row below the column descnpuon in reference to column A (name of

- project) type the new value.

3.8 Updating Key 'Para'n_}eter'!_)ata Base

1. Click the File menu. select Open.

Short-cut: Click the Open button.
2. From the Open Dialog Box. Select the keypar.xis filename.
3. To update the Key Parameter Data,

click the tab of STable 2.6.2 sheet.

Water Supply.

Number of Household to be Served by Level I Factitty move mouse po:nter to
colurmn H-Row 5. Type the new valte,

Water Consumption Rate for Level Il System: move mouse pomter to column H-
Row 6. Type the new value ' :

Sanitation:

Standard Number of Student to be Served by a Unit of San:rary Toilet: move mouse
painter to column H-Row 8. Type the new value, :

Standard Number of Toilets for Public Facrh!y move mousg pomter to column H-
Row 9, Type the new value. -

Medium-term P!cm

*

Percentage of Population Covered by Urban Water Supply move mouse pmntcr o
co!umn H-Row 1} Type the new value. :

Percentage of Papu!atwn Covered by Rural Water Supply: move mouse pointer to
column H-Row [2. Type the new value,
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Percentage of Population Covered by Sanitary Toilet: move mouse pointer to
column H-Row 14, Type the new value.

Percentage of Urban Household Caovered by Flush Toilei: move mouse pointer to
colummn H-Row 6. Type the new value.

Percentage of Urbon FHousehald Covered by Pour Flush Toiler: move mouse
pointer to column H-Row 17. Type the new value.

Percentage of Urban Household Cavered by VIP Latrine: move mouse pointer to
column H-Row 18, Type the new value.

Percentage of Rural Houschold Covered by Flush Toilet: move mouse pointer to
column H-Row 20. Type the new value,

Percentuge of Rural Household Covered by Pour Flush Toilet: move mouse pomter
to column H-Row 21. Type the new value.

Percentage af Rural Household Covered by VU’ Latrine: move mouse pointer to
column H-Row 22. Type the new value.

Percentage of Public Student Covered by School Toilet: move mouse pointer to
column H-Row 23. Type the new value,

Percentage of Public Utility Covered by Publm Toilet: move mouse pointer to

column H-Row 24. Type the new value.

Pércentage of Population Covered by Solid Waste Collection: move mouse pointer
to column H-Row 25. Type the new value.

Long-term Plan:

Percentage of Population Cavered by Urban Water Supply: move mouse pointer to
column H-Row 27. Type the new valie.

Percentage of Population Covered by Rural Water Supply: move mouse pointer to

" column H-Row 28. Type the new value.

Percentage of Population Covered by Sanitary Toilet: move mouse pointer to
column H-Row 30. Type the new value.

Percentage of Urban Household Covered by Flush Totlet move mouse poinier to

column H-Row 32. Type the new value.

- Percentage of Urban Household Covered by Pour Flush Tuoilet: move mouse

pointer to column H- Row 33. Type the new value.

_ Percentage of Urban Household Covered by VIP Latrine; move mouse pointer to
- cofumn H-Row 34. Type the new value. :

Percentage of Rural Household Covered by Flush Toilet: move mouse pointer to
column H-Row 36, Type the new value.

.- Percentage of Rural Househald Covered by Pour Flush Toilet: move mouse pointer

to column H-Row 37, Type the new value,

Percentage of Rural Hm.ise_hald Covered by VIP Latrine: move mouse pointer to
column H-Row 38. Type the new value.

Percentage of Public Student Covered by School Toilet: move mouse pointer to
column H-Row 39, Type the new value.
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Percentage of Public Unlity Covered by Public Teilet: move mouse pointer to
column H-Row 40. Type the new value,

Percentage of Population Covered by Urban Sewerage: move inouse pointer (o
columnn H-Row 41, Type the new value.

Rehabilitation:

[

Percentage of Level I Wells for Rehabilitation: move mouse pointer io column H-
Row 42. Type the new value.

Sector Management Cost:

Percentage of Feasibility and Detail Design: move mouse pointer to column H-Row
44. Type the new va]ue

Percentage of Construction Supervzswn move mouse pomter to column H-Row 45,
Type the new value.

Contingencies:

Percentage of Physical Contingency: move rouse pointer to column H-Row 47,
Type the new value.

Percentage of Price Contmgency move mouse pointer to column H- Row 48. Type
the new value. '

Community Development and Trammg Cost:

Percentage for Level IH Sysfem: move mouse pointer o column H Row 50. Type
the new value.

Percentage for Level I F actlity and Lével s jsrem: move mouse pointer 1o column
H-Row 51. Type the new value.

Recurrent Cost:

Operating Cost for Level III System: move mouse pomter to column H- Row 52.
Type the new value. :

- Cost of Spare Parts/Equipment for Level 11T Systcm MOove mouse pointer to

column H-Row 53, Type the new value. -

- Cost of Spare Parts/Equ:pment for LeveI It System move mouse pom[er to column

H-Row 54. Type the new value,

Cost of Spare Parts/FEquipment for Level I Facility: move mouse pomter to column
H-Row 55. Type the new value. :

- Public School Toilet Mamtenance Cost maove mouse pointer to co!umn H- Row 56.

Type the new value.

Public Utility'T oilet Maintenance Cost: move mouse painter to column H-Row 57.
Type the new value,




Allocation Factors/Percentages of IRA:

Percentage Share from Provinciol IRA: move mouse pointer o column H-Row 59,
Type the new value,

Percentage Share from Municipal/Barangay IRA: move mouse pointer to column
H-Row 60. Type the new value,

Funding Levels/Percentages for Different Financing Scenarios:

.

Ist Scenario: move mouse pointer ta column H-Row 62. Tyﬁe the new value.
Znd Scenario: move mouse pointer to column H-Row 63. Type the new value.
3rd Scenario: move mouse pointer to cotumn H-Row 64, Type the new value.
4th Scenario: move mouse pointer to column H-Row 65. Type the new valye.

5th Scenario: move mouse pointer to colomn H-Row 66. Type the new value.,

click the tab of $Table 2.6.3 sheet:

Fercentage Proportion of Water Source: move mouse pointer to column D. Starting
at the row below the column description, in reference to column A (name of
municipality), colimn B (type of area), column C (type of source) select the data you
would like to update and type the new value.

Range Depth af Well: move mouse pointer ta column E. Starting at the row below
the column description, in reference to column A (name of municipality), column B
(type of area), colummn C {type of source) select the data you would like to update and
type the new value,

Average Specific Capacity: move mouse pointer to column F. Starting at the row
below the column description, in reference to column A (name of municipality),
column B (type of area}, column C (type of source) select the data you would like to
update and type the new vafue.

click .the tab of STqble 2.0.5 sheet.

L

Unsafe Percentage: move mouse painter to column C. Starting at the row below the
column description, in reference to column A (name of mumupultty) select the data
you would like to update and type the new value.

click the tab of STable 2.6.6 sheet.

Unit Canstructioﬁ Cast for New Level III -System for 5,000 population: move

mouse pomtcr to column B Row 7. Type the new value.

Unit Coustructmn Cost for New Level HT System for 1 0, 000 population: move
mouse pointer to column B-Row 8. Type the new value.

“Unit- Construction Cost for New Level TIT System far 15,000 popu!anou move

mouse pointer to column B-Row 9. Type the new value.

Unit Constructions Cost for Level [l System Expanswrt for 5, 000 populatmn move
mouse pointer to column B-Row 11. Type the new value,

2-89



Unit Construction Cost for Level IlI System Expansion for 10,000 population:
move mouse pointer to column B-Row 12. Type the new value,

Unit Construction Cost for Level III System Expansion for 15,000 population:
move mouse pointer to column B-Row 13, Type the new vale.

Unit Construction Cost for Level IT System: move mouse pointer to column B-Row
14, Type the new value.

Unit Construction Cosit for Level I' Facility (Deep Eell - 40 meter depth): move
mouse pointer to column B-Row 16. Type the new value.

Unit Construction Cost for Level I Facility .'(Deep Well - 80 meter depth}: move
mouse pointer to column B-Row 7. Type the new value.

Unit Construction Cast for Level I Facility (Deep Well - 120 meter a’epih).‘ move
monse pointer to column B-Row 18. Type the new value.

Umf Construction Cost for Level I F'acrluy (Shallow Well): move mouse pointer to
column B-Row 19. Type the new value,

" Unit Construction Cost for Rehabilitation of Level I F acility: move mouse pointer

to column B-Row 20. Type the new value,

“Cost for Disinfection of Level I Welis ‘move mouse pomler to column B-Row 21,

Type the new value.

Unit Construction Cost for Flush Toilet: move mouse pointer to column B-Row 22.
Type thc new value,

Unit Construction Cost for Pour Flush Toiler: move mouse pointer to column B-
Row 23. Type the new value. '

Unit Construction Cost for VIP Latnne Toilet: move mouse pointer to column B-
Row 24, Type the new value.

Unit Construction Cost for SchooI To:let move mouse pomter to column B-Row -
23. Type the new value.

Unit Construction Cost for Public Toilet: move mouse pointer to column B-Row 26.
Type the new value.

Unit Constructwn Cost for Urban Sewerage move mouse pomter te column B-Row
27. Type the new value.

click the tab of STable 2.6.4 sheet,

Urban Water Supply (Level IIT System):

Feasibility Study and Detail Design: move mouse pointer to Row 6. Starting at
Column F (Year 1996) up to Column J (Yeuar 2000) select the data you would like to
update and type the new value,

Construction and Supervision: move mouse pointer to Row 7. Starting at Column F

(Year [996) up to Column I (Year 2000) select the duta you would like fo update and
type the new value,

Cammuhz'ty Develapmerif and Train’ing. move mause: pofnter to Row 8. Starting at
Column F (Year 1996) up to Column J (Year 2000) select the data yon would like to
update and type the new value,
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Rural Water Supply (Level I Facility):

Detail Design: move mouse pointer to Row 10. Starting at Columin F (Year 1996) up
to Column I (Year 2000) select the data you would like to update and type the new
value.

Construction and Supervision: move mouse pointer to Row | I. Starting at Column

F (Year 1996) up to Column J (Year 2000) select the data you would like to update
and type the new value,

Communily Development and Training: move mouse pointer to Row 12. Starting at

. Column F (Year 1996) up to Column I (Year 2000) select the data you would like to

update and type the new value.

Rural Water Supply (Level IT System).

Detail Design: mave mouse pointer to Row 14. Smmng at Column F (Year 1996) up

to Column J (Year 2000) select the data you would like to update and type the new
value.

Construction and Supervision: move house poinier to Row 15. Starting at Column
F(Year 1996) up to Column J (Year 2000) select the data you would like to update
and type the new value.

Cominunity Development and Training: move mouse pointer to Row 16, Sfaning at
Column F (Year 1996) up to Column J { Year 2000) select the data you would like to
update and type the new value.

Sanitatfan:

Urbarn Hausehold Toilet: move moise pointer to Row 17. Starting at Cofumn F
(Year 1996) up (o Column J (Year 2000) select the data you would like to update and
type the new value. .

Rural Household Toz‘fer."move mouse poiriter to Row 18. Staﬁing at Column F

. (Year 1996) up to Column I (Year 2000) select the daia you would like to update and

type the new value.

Public School Tailet: move mouse pointer ta Row 19 Staﬁiﬁv at Column F (Year
1996) up to Column J (Year 2000) select the data you would like to update and Wpe
the new value,

Public Tailet: move mouse pointer to Row 20. Starting at Column F (Year 1996) up
to Column J (Year 2000} select the data you would like to update and type the new
value,

‘Disinfection of Level I Wells: move mouse pointer to Row 21. Starting at Column F

(Year 1996) up to Column J (Year "000) select the data you would like to update and
type the new value.

Detail Design: move mouse pointer to Row 22. Starting at Cofumn F (Year 1996) up

to Column J {Year 2000) select the data you would like to update und type the new
value.

Construérion and Supervision: move mouse pointer to Row 23, S[dl’tiﬁ*’ at Column
F {Year 1996) up to Column I (Year 20000 select the data you would like to update
and type the new value.



Community Development and Training: move mouse p'oi_nter to Row 24, Starting at
Column F (Year 1996) up to Column J (Year 2000) select the data you wouid like o
update and type the new value.

click the tab of STuble 2.6.7 & 2.6.8 sheer.

Seoring Factor for Municipal Investment Ranking for Urban Water Supply:

*

Minimun Percenrage of Underserved and Unserved Population in Base Year: move
mouse pointer to column B, in reference to column A (score) select the data you
would like to update and type the new value,

Maximum Percentage of Underserved and Unserved Population in Base Year: move
mouse pointer to column D, in reference to column A (score) select the data you

- would like to update and type the new value.

Weight Allocation Score for Underserved and Unserved Population in Base Year:
move mouse pointer to column C-Row 9. Type the new value, :

Minimun Percentage af Underserved and Unserved Papulanan in Phase I move

" mouse pointer to column E, in reference to column A (score) select the data you

would lll\e to update and type the new value.

Maximu Percenrage of Underserved and Unserved Popuiahon in Phase I. move
mouse pointer to column G, in reference to column A (score) select the data you
would like to update and type the new value.

Weight allocation Score for Underserved and Unserved Population in Phase I. move
mouse pointer to column F-Row 9. Type the new value.

Minimun Percentage of Underserved and Unserved by Level {11 System in the Base

Year: move mouse pointer to column H, in reference to column:A (score) select the
data you would like to update and type the new value.

Maximum Percenmge of of Underserved and Unserved by Level IIT System in the
Base Year: move mouse pointer to column J, in reference to column A (score) select
the data you would like to update and type the new value.

Weight Allacation Scoreé for Underserved and Unserved by Level 1H Svstem in the
Base Year: move mouse pointer to column I-Row 9. Type the new value.

Scoring Factor for Municipal C_'qmprehensive Investment _Ranking:

Minimun Percenrage of Rural Water Supply: move mouse pointer to column E, in
reference to column A (score) at starting at row 15, select the data you would like to
update and type the new value.

. Maximum Percentage of Rural Water Supply: move mouse pointer 1o column G, in
_reference to column A (score) at starting at row 13, select the dat you would like to

update and type the new value.

Weight Allocation Score for Rural Water Supply: move mouse pomler to column F-
Row 20. Type the new value, :

Minimun Percentage of Urban Sanitation: move mouse pointer to column H,
reference to column A (score) at starting at row 15, bEIECl the data you would hke {o]
update and type the new value,




*  Maxinum Percentage of Urban Sanitation: move mouse pointer to column J, in
reference to column A (score) at starting at row 15, select the data you would like to
update and type the new value.

Weight Allocation Score for Urban Sanitation: move mouse pointer to column [-
Row 20. Type the new value.

«  Minimun Percentage of Rurel Sanitation; move mouse pointer to column K, in
reference 1o column A (score) at starting at row 15, select the data you would like to
update and type the new value. '

«  Maximum Percentage of Rural Sanitation: move mouse pointer to column M, in
reference to calumn A (score) at starting at row 15, select the data you would like 1o
update and type the new value,

. Wéight Allocation Score for Rural Sanitation: move mouse pointer to column L-
Row 20. Type the new value.

Updating Unit Construction Cost Data Base
Water Supply

1. Click the File menu, select Open,
Short-cut: Click the Open button.

- 2. From the Open Dialog Box. Select the chap-{0.xls filename.

3.1.To update the Unit Cost for Level ITT (5,000 population).
click the tab of STable 10.2.7 sheet.

« Quantity: move mouse pointer to colurnn C. Starting at the row below the column
description, in reference to column B (u:ern description) setect the data you would
like to update and type the new value.

¢ Unit Cost: move mouse painter to column E Starting at the row below the column
description. in reference to column B (item description) select the data you would
like to update and type the new value.

3.2.To update the Unit Coat for Level OT (10,000 pupulatmn)
click the tab of STable 10.2.8 sheet.

¢ (Quantity: Move mouse pointer to column C. 'Smnihv at the row below the column
description, in reference to column B (item de:,cnpuon) select the data you wouid
like to update and type the new value.

« Unit Cost: move mouse pomter to cotumn E. Starting at the row below the column
descrlptlon in reference to cofumn B (item description) select the data you would
like to update and type the new value.

33To updété the Unit Cost for Level TI {IS..,OOO population),
click the tab of STable 10.2.9 sheet,

+  Quantity: move mouse painter to column c. Stamng at the row below the column
description, in reference to column B (item deacnptmn) aelect the data you would
like to update and type the new value.
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*  Unit Cost: move mouse pointer to colurnn E, Starting at the row below the column
- description, in reference to column B (item description) select the data you would
like to update and type the new value.

3.4.To update the Unit Cost for Level I (600 popuiation),
click the tab of STable 10.2.6 sheet,

« Lumnp Cost of Spring Box: move mouse pointer to column G-Row-4. Type the new
value.

*  Quantity of Installation of Pipelines and Fittings: move mouse pointer to column D.
Starting at the row below the column description, in reference to column B (item
description) select the data you would like to update and type the new value.

*  Unit Cost of Installation of Pipelines and Fittings: move mouse pointer to column
F. Starting at the row below the column description, in reference to column B (item
description) select the data you would like to update and type the new value.

3.5.To update the Unit Cost for Level I (Deep Well - 40 m depth),
click the tab of STable 10.2.1 sheet,

*  Lump Sum Cost of Mobilization/Demobilization: move mouse pointer to column F-

Row-4. Type the new value.

¢  (Juantity: move mouse pointef to column C. Starting at the row below the column
description, in reference to column B (itern description) select the data you would
like to update and type the new value. .

¢ Unit Cost: move mouse pointer to column E. Stamnc at the row below the column

description, in reference to column B (item descnpuon) select the data you would
like to update and type the new value.

3.6.To update the Unit Cost for Level I (Preep Well - 80 m depth),
click the tab of STahle 10.2.2 sheet.

* Lump Sum Cost of Mabxl:._atwn/Demab:hzarmn move mouse pointer to column E-

Row-4. Type the new value.

Quantity move mouse pointer to column C. Starting at the.row below the column

description, in reference to column B (item description) select the data you would
like to update and type the new value

Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, ‘in rcfcrence to column B (|tem description) select the data you would
like to update and type the new value

3.7.To update the Unit Cost for Level I (Deep Well - 120 m depth)
click the tab of STable 10.2 3 sheet.

_ Row-4 Type the new value

Quantity: move mouse pointer to cciumn C. St.mmﬂ at tht. row below the column
description, in reference to column B (item description) setect the data you would
like to update and type the new va]ue
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Lump Sum Cost of Mobthattan/Demob:hzancm move mouse pomtr:r to column F-




e Unit Cost; move mouse pointer to column E. Starting at the row below the column
. description, in reference to column B (item description) select the data you would
like to update and type the new value,

3.8.To update the Unit Cost for Level I (Deep Weil Rehabilitation),
click the tab of STable 18,2.4 sheet.

*  Lump Sum Cost of Mobhilization/Demobilization: move mouse pointer to column F-
Row-4. Type the new value.

e Quantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

=  Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value.

3.9.To update the WUnit Cost for Level T (Shallow Well - 18 m depth),
click the tab of STable 7¢.2.5 sheet,

«  Lump Sum Cost of Mobilization/Demaobilization: move mouse pointer to column F-
Row-4, Type the new value.

* - (uantity: move mouse pointer to column C. Starting at the row below the column
description, in reference to column B (item description) select the data you would
g like to update and type the new value.

«  Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description) select the data you would
like to update and type the new value,

'8.9.2. Environmental Sanitation

1. Click the File menu, select Open.
" Short-cut: Click the Open button.
-2. From the Open Dialog Box. Select the chap-10.xls filename,
3.1.To update the Unit Cost of Flush Water Sealed Toilet with Septic
click the tab of STable 10.2.10 sheet.

«  Quantity; move mouase pointer to column C. Starting at the row below the column
description, in reference ta colurmn B (item description) select the data you would
like to update and type the new value.

+  Unit Cost: move mouse pointer to column E. Starting at the row below the column
description, in reference to column B (item description) select the data you would
. like to update and type the new value.

3.2. To update the Unit Cost of Pour Flush Toilet with Double Pit Latrine
click the tab of STable 10.2.11 sheel.

* Qnantity: move mouse pointer to column C. Stating at the row below the coiumn
description, in reference to column B (item description) select the data you would
like to update and type the new value.
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¢ Unit Cost. move mouse pointer to column E. Siarting at the row below the column

description, in reference to colurnn B (itern description) select the data you would
like to update and type the new value.

3.3.To update the Unit Cost of Ventilated Improved Pit L:itrine (VIP)
click the tab of STable 10.2.12 sheet.

#  (uaniity; move mouse pointer to column D. Starting at the row below the column
description, in reference to column C (item description) select the data you wouid
like to update and type the new value.

e Unit Cost: move mouse pointer to column H. Starting at the row below the coluinn
description, in reference to cofumn C (item description) select the data you would
like to update and type the new value.

3.4.To update the Unit Cost of School Toilet
click the tab of STable 10.2.13 sheet.

* Quantity: move mouse pointer to column D. Starting at the row below the column -

description, in reference to column C (itern description) select the data you would
like to update and type the new value. :

*  Unit Cost; move mouse pointer to column H. Starting at the row below the columin

descnpnon in reference to column C (item descnpnon) select the data you would
like to update and type the new value.

3.5.To update the Unit Cost of Public Toilet
click the tab of STable 10.2.14 sheet.

* Quantity; move mouse poinier to column D. Starting at the row below the column
description, in reference to column C (item descnpt:on) ‘select the data you would
like to update and type the new value.

* Unit Cost: move mouse pointer to column H. Starting at the row below the column

description, in reference to column C (item descnpuon) select the data you would
like to update and type the new value.

Standard Report Format

The following pagé desc_:ribes the standard 'report format. Please refer to MS-Word Basic -

Operation in Section 5 for procedure in setting the MS-Word environment. -




Specification for Standard Report Format

- - Edge of paper. Title of section ~ ——w—,
4., EXISTING FACILITIES AND SERVICE COYERAGE—
4.1. Water Supply — Sub-section
: Text box o]
4.2, General
All around margin - 1" =

This is an example output of the main text.

g Spacing between paragrpah - I blunk line.

Type and composition of water supply facilities are classified into
three service levels based on the definition given in the WNational
Sector Master Plan and presented in Table 4.1.}. Various types of
Level T Facilities/sources defined to safe and unsale sources by DOH.
This classification adopted for preparation of PW4SP does not
disregard the facts that the existing improved/covered dug well is
sometimes yielding non-potable water.

—«—-—I— Ist indent - 0.5"

{1} Problem areas

I—-—{“-—-—*H 2nd indent - 0.25"
Problem areas are identified through review of the exsiting water
supply facilities and countermeasures and recommendations for

* their improvement are prepared to reflect on the future planning in

PWA4SP,

1) Level I facilities

Comments on each sub-title shall be followed in the manner
JRLLL

as shown herewith,
“— Line spacing - 1.5 line.

1‘1. Driven shallow wells

Most of driven shallow wells are exposed 1o danger of
pollution through seepage of surface water,

_ 3Ird indent - 0.23"
— 4ih indent - 0.25

Standard settings;

Standard Font - New Roman Times,

Font Size - 11 points.

Paragraph - Jusiified alignment.

Title of Section - Bold Font, All Upper Case.
Sub-Scction - Bold Font, First Letter Upper Cuse,

All around meirgin - 1"
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